User Manual
Chirascan Series Spectrometers

Chirascan and Chirascan-plus Circular Dichroism Spectrometers
February 2012

Document 4207Q108C03.01
This page is intentionally left blank
This document contains important safety information. Read this document before attempting to install or use the Chirascan or Chirascan-plus spectrometer. Failure to do so could result in death or serious injury.
USE OF THIS DOCUMENT

This document is intended to inform the operator of Applied Photophysics’ Chirascan series (Chirascan and Chirascan-plus) spectrometers on their design, installation and operation. Some of the items that may be supplied with the spectrometer, for example the Workstation (PC) and temperature control circulator are manufactured by external companies, and are supplied with separate User Manuals provided by those companies. The operator should be familiar with the contents of those manuals, and in particular with the safety and other hazard information contained therein. Note that some of the images of the interior of the spectrometer Sample Handling Unit show the CS/PCS Single Cell Accessory fitted. Users who do not have this accessory should ignore these and other references to the CS/PCS in this User Manual.

The information in this document is subject to change without notice and should not be construed as a commitment by Applied Photo physics, who accept no responsibility for errors that may appear herein. This document is believed to be complete and accurate at the time of publication, and in no event shall Applied Photo physics be held responsible for incidental or consequential damages with or arising from the use of this document.

COPYRIGHT © 2012 APPLIED PHOTOPHYSICS LTD. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF SHALL NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE PUBLISHER.

THE SOFTWARE PROVIDED WITH THE SPECTROMETER (PRO-DATA CHIRASCAN, PRO-DATA VIEWER, ETC.) IS THE PROPERTY OF APPLIED PHOTOPHYSICS LTD. (“APL”) AND IS SUPPLIED UNDER LICENCE. APL IS WILLING TO LICENSE THE SOFTWARE ONLY UPON THE CONDITION THAT THE LICENSEE ACCEPTS ALL THE TERMS CONTAINED IN THE LICENCE AGREEMENT. THESE INCLUDE THAT THE LICENSEE MAY NOT SELL, RENT, LOAN OR OTHERWISE ENCUMBER OR TRANSFER LICENSED SOFTWARE IN WHOLE OR IN PART TO ANY THIRD PARTY. FOR A FULL COPY OF THE LICENCE PLEASE CONTACT APL OR SEE THE SOFTWARE INSTALLATION DISC.

Chirascan™ and Chirascan™-plus are trademarks of Applied Photophysics Ltd.

Microsoft®, Windows® and Excel® are registered trademarks of Microsoft Corporation in the United States and other countries.

Adobe® and Reader® are registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Norton™ is a trademark of Symantec Corporation or its affiliates in the United States and other countries.

McAfee® is a registered trademark of McAfee, Inc. in the United States and other countries.

Sophos® is a registered trademark of Sophos plc and Sophos Group.

Cary® and Agilent® are registered trademarks of Agilent Technologies Inc.

Julabo® is a registered trademark of Julabo Labortechnik GmbH.

Sigma-Aldrich® is a registered trademark of Sigma Aldrich Co., Missouri, United States.

All other trademarks or registered trademarks are the sole property of their respective owners.
HAZARD AND OTHER INDICATORS

HAZARD INDICATORS USED IN THIS DOCUMENT

⚠️ WARNING ⚠️ The sign to the left is used to indicate a hazardous situation, which, if not avoided, could result in death or serious injury.

⚠️ CAUTION ⚠️ The sign to the left is used to indicate a hazardous situation, which, if not avoided, could result in minor or moderate injury.

OTHER INFORMATORY INDICATORS USED IN THIS DOCUMENT

⚠️ NOTICE ⚠️ The sign to the left is used to indicate a situation which, if not avoided, could result in damage to the instrument.

HAZARD INDICATORS USED ON THE SPECTROMETER OR ACCESSORIES

Note that these hazard indicators may be either coloured as below or as black and white.

⚠️ The sign to the left is a general hazard indicator, indicating the presence of a hazard that is either described by text accompanying the sign or in this User Manual.

⚡ The sign to the left is a High Voltage hazard indicator.
ESSENTIAL SAFETY INFORMATION

MAKE SURE THAT YOU HAVE READ AND UNDERSTAND ALL THE SAFETY INFORMATION CONTAINED IN THIS DOCUMENT BEFORE ATTEMPTING TO OPERATE THE CHIRASCAN SERIES SPECTROMETER. IF YOU HAVE ANY QUESTIONS REGARDING THE OPERATION OF YOUR SPECTROMETER, PLEASE CONTACT APL TECHNICAL SUPPORT SECTION AT THE ADDRESS SHOWN ON THE FIRST PAGE OF THIS DOCUMENT.

OBSERVE ALL SAFETY LABELS AND NEVER ERASE OR REMOVE SAFETY LABELS.

PERFORMANCE OF INSTALLATION, OPERATION OR MAINTENANCE PROCEDURES OTHER THAN THOSE DESCRIBED IN THIS USER MANUAL MAY RESULT IN A HAZARDOUS SITUATION AND WILL VOID THE MANUFACTURERS WARRANTY.

The Chirascan and Chirascan-plus spectrometers are powered by the mains electricity supply which can produce an electric shock leading to serious injury or death. Do not connect or disconnect the spectrometer from the mains supply unless the supply is powered off at source. Ensure all communications and electrical connections are made before powering on the spectrometer. Exercise care during operation and do not operate units with their covers removed. Operate the spectrometer using only the cables provided. Never operate a spectrometer with damaged cables.

The metal components of the spectrometer can produce an electric shock leading to serious injury or death if they are not earthed (grounded). The design of the spectrometer provides protection against electric shock by earthing appropriate metal components. This protection will be lost unless the power cable is connected to a properly earthed outlet. It is the user’s responsibility to ensure that a proper earth connection can be made.

The photomultiplier tube (PMT) detector used with the Chirascan and the avalanche photodiode (APD) detector supplied with the Chirascan-plus operate at high voltages and can produce an electric shock leading to serious injury or death. Do not connect or disconnect the detector from the spectrometer unless the spectrometer is powered off.

The spectrometer may be equipped with a light source (150 watt xenon or mercury-xenon arc lamp) that produces intense ultraviolet radiation that can irritate the eyes and may impair eyesight. Never look directly at the light source. Do not open the lamp housing while the lamp is operating or immediately after it is powered off. Do not allow the skin to be exposed to UV radiation.

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very reactive gas that is damaging to health and may cause deterioration of the optical components of the instrument. If an ozone producing lamp is used, it essential that the spectrometer is thoroughly purged with nitrogen before the lamp is powered on.

The electronic circuitry used in the spectrometer is very sensitive and must be correctly grounded to avoid electrical interference. It is the user’s responsibility to ensure that a proper earth connection can be made.
The lamps used in the spectrometer operate at high pressure and can explode or break without warning, causing damage to the interior of the lamp housing. This is more likely to happen with lamps with longer usage, and lamps with more than 1000 hours usage should be replaced.

Corrosive chemical and organic solvents can cause damage to the spectrometer. Do not allow corrosive fluids to come into contact with any part of the spectrometer. Do not clean the spectrometer with organic solvents. Use only a soft cloth and water or a mild detergent solution. It is good practice to load the sample into the sample cell before the cell is installed in the cell holder.
CHRASCAN SERIES INSTALLATION AND OPERATIONAL REQUIREMENTS

Environmental requirements
The spectrometer is best installed in a safe position, in a clean, air-conditioned laboratory environment.

Operating conditions
Temperature: 20°C to 25°C controlled to within 1.5°C.
Humidity: 20% to 80% non-condensing
Dust levels: minimum

Storage conditions
Temperature: -20°C to +50°C
Humidity: 5% to 80% non-condensing

Bench space
The spectrometer with CS/PCS Single Cell Temperature Accessory or CS/PCM 4-cell Autochanger, CS/TITration Accessory and CS/SEM Scanning Emission Monochromator Accessory requires a bench space of:

Length x depth x height: 2.2 x 0.8 x 0.5 metres

A sturdy, stable, vibration-free work surface is recommended.

Electrical requirements
The spectrometer is supplied with a filtered mains distribution board which requires an earthed (grounded) mains electricity supply of between 85 and 285 V AC 50/60 Hz, 1000 W maximum.

Applied Photophysics recommends the use of an uninterruptable power supply (UPS) rated to 1500 VA minimum, such as the APC Smart-Ups SUA 1500i.

Computer requirements
The spectrometer is normally supplied with a computer. However, some users may wish to use run the instrument from their own PC. This should be a Windows 7 Pro ready PC, ≥ 2.4 GHz, 2 GB RAM, ≥ 2 GB hard drive, 1 free PCIe slot.

Nitrogen purge gas
Unless used with an non-ozone producing lamp, the spectrometer requires constant purging with 99.998% oxygen free nitrogen at a pressure of 4 to 6 bar (60 to 90 psi) and flow rate of at least 5 litres per minute.

Fluid circulator unit
The spectrometer can be used with or without temperature control. If used with the CS/PCS Single Cell Temperature Accessory or CS/PCM 4-Cell Autochanger Accessory for temperature control, a water circulator is required with a minimum pressure of 0.2 bar, maximum 1.7 bar (3 to 25 psi). A CS/JS Recirculating Cooler or a CS/B100 Circulator, both available from Applied Photophysics, is recommended.
GENERAL INFORMATION

Computer configuration
Your Chirascan series spectrometer is normally supplied with an HP Compaq PC, pre-configured for use with the instrument. However, there are some issues that you need to be aware of, described below.

Administrator login
No password is set by APL for the Administrator account. Customers are advised to set the Administrator password of the Chirascan PC themselves.

APL Service Account
The user account “APLService” has been created and given Administrative privileges by APL. This account will be used by APL engineers during servicing of your spectrometer. Do not remove this user, or change the password.

Chirascan User Login and the Chirascan Users Group
The user account “Chirascan User” has also been created by APL. Chirascan series spectrometer users may login as “Chirascan User”, or the system administrator may create individual user accounts. A “Chirascan Users” group has also been created, and users should be made members of this group. If the Chirascan PC is connected to a network then this may affect the way in which users logon to the Chirascan PC. The system administrator should ensure that “network” or “domain” users who want to use the Chirascan software are members of the “Chirascan Users” group.

Virus protection
The HP Compaq PC may be supplied with a trial version of a 3rd party anti-virus package. APL recommends that the Chirascan PC has up-to-date anti-virus software installed at all times. Most customers will have a preferred anti-virus software package, and APL generally recommends that the anti-virus software which is supported by the customers’ ICT department be installed on the Chirascan PC. However, please see the section on installing 3rd Party software below.

Networking
The Chirascan PC is supplied with networking capabilities. However, before the Chirascan PC is connected to a network, the System Administrator should ensure that appropriate anti-virus (and optionally anti-spyware) software is installed and maintained. APL cannot be held responsible for failure of the Chirascan PC due to viruses or other malware.

Installation of 3rd Party Software
The Chirascan Pro-Data suite is not compatible with most 3rd party firewall programs, including Norton, McAfee and Sophos firewall programs. The Pro-Data suite is compatible with Windows built-in firewall, provided that Chirascan Pro-Data software is listed as an exception. APL is not aware of any other conflicts with 3rd Party Software., and will not be held responsible for failure of the Chirascan software because of any such conflict.

Upgrading Software and/or Hardware
The Chirascan software has been developed for use with Microsoft Windows software and has been extensively tested on the PC’s supplied by APL. APL cannot be held responsible for failure of the Chirascan software if the Chirascan user or system administrator upgrades the PC, or the PC’s Operating System.
Technical Support and Licensing
APL will provide technical support, under the terms of the Service Level Agreement, for the Chirascan software, subject to the Chirascan Software Licence, and for the supplied PC. However, APL cannot be held responsible for failure of the software or hardware through misuse or neglect by the customer.

If you have any queries relating to the Chirascan software or the HP Compaq PC, please contact APL Technical Support at the address given on the front of this User Manual.

Servicing
Servicing of the Chirascan and its accessories should only be undertaken by qualified personnel. If you are in any doubt at all please contact the Applied Photophysics Technical Support Department at the address given on the front of this User Manual.
GLOSSARY

The following abbreviations are used in the descriptive text in this User Manual:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Alternating current</td>
</tr>
<tr>
<td>APL</td>
<td>Applied Photophysics Ltd.</td>
</tr>
<tr>
<td>AU</td>
<td>Absorbance units</td>
</tr>
<tr>
<td>CD</td>
<td>Circular dichroism</td>
</tr>
<tr>
<td>CPL</td>
<td>Circularly polarized light</td>
</tr>
<tr>
<td>DC</td>
<td>Direct current</td>
</tr>
<tr>
<td>FWHH</td>
<td>Full width at half height</td>
</tr>
<tr>
<td>HT</td>
<td>High tension – the same as high voltage</td>
</tr>
<tr>
<td>HV</td>
<td>High voltage</td>
</tr>
<tr>
<td>L/min</td>
<td>Litres per minute</td>
</tr>
<tr>
<td>M</td>
<td>Molar (i.e. mol dm$^{-3}$)</td>
</tr>
<tr>
<td>SBW</td>
<td>Spectral bandwidth</td>
</tr>
<tr>
<td>SF</td>
<td>Stopped flow</td>
</tr>
<tr>
<td>SS</td>
<td>Step size</td>
</tr>
<tr>
<td>UV</td>
<td>Ultraviolet</td>
</tr>
</tbody>
</table>

The following abbreviations relate to components of the Chirascan spectrometer:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APD</td>
<td>Avalanche photodiode</td>
</tr>
<tr>
<td>ESHU</td>
<td>Equilibrium sample handling unit</td>
</tr>
<tr>
<td>FDCD</td>
<td>Fluorescence detected circular dichroism</td>
</tr>
<tr>
<td>KSHU</td>
<td>Kinetic sample handling unit</td>
</tr>
<tr>
<td>LAAPD</td>
<td>Large area avalanche photodiode</td>
</tr>
<tr>
<td>LED</td>
<td>Light-emitting diode</td>
</tr>
<tr>
<td>PEM</td>
<td>Photoelastic modulator</td>
</tr>
<tr>
<td>PMT</td>
<td>Photomultiplier tube</td>
</tr>
<tr>
<td>SCP</td>
<td>Spectrometer control panel</td>
</tr>
<tr>
<td>SHU</td>
<td>Sample handling unit</td>
</tr>
</tbody>
</table>

HYPERLINKS

This document contains hyperlinks between references (for example the Contents tables, or references to Sections or Figures in the text) and sources. To follow a link, place the cursor over the reference and use **CTRL+click**. Hyperlinks in the text are indicated by underlined [blue font].
CONTENTS

USE OF THIS DOCUMENT ............................................................................................................. 4
HAZARD AND OTHER INDICATORS .......................................................................................... 5
ESSENTIAL SAFETY INFORMATION ............................................................................................ 6
INSTALLATION AND OPERATIONAL REQUIREMENTS ................................................................. 8
GENERAL INFORMATION ............................................................................................................ 9
GLOSSARY ..................................................................................................................................... 11
CONTENTS .................................................................................................................................... 12
FIGURES ....................................................................................................................................... 16
TABLES ......................................................................................................................................... 19

1 INTRODUCTION .......................................................................................................................... 20

2 QUICK START ............................................................................................................................... 22
  2.1 Purging ..................................................................................................................................... 22
  2.2 Powering on ............................................................................................................................... 23
  2.3 Launching the software ............................................................................................................. 25
  2.4 Measuring a CD background and spectrum ............................................................................. 26
     2.4.1 The CD background ............................................................................................................... 26
     2.4.2 The CD spectrum .................................................................................................................. 28
  2.5 Viewing and manipulating spectra ........................................................................................... 29
     2.5.1 Viewing spectra .................................................................................................................... 30
     2.5.2 Comparing spectra ............................................................................................................... 31
     2.5.3 Manipulating spectra ............................................................................................................ 31
  2.6 Saving, exporting and converting data ...................................................................................... 35
     2.6.1 Saving data .......................................................................................................................... 35
     2.6.2 Exporting data from Pro-Data Viewer ................................................................................ 35
     2.6.3 Converting data for use with third-party programs ............................................................. 36
  2.7 Printing .................................................................................................................................... 37
  2.8 Operating notes and hints ........................................................................................................ 37
     2.8.1 Selecting Step Size (SS) ...................................................................................................... 37
     2.8.2 Selecting Spectral Bandwidth (SBW) ................................................................................ 38
     2.8.3 Selecting pathlength and concentration .......................................................................... 38
     2.8.4 Selecting the time-per-point ............................................................................................. 39
     2.8.5 Measuring protein spectra ................................................................................................. 39
  2.9 Example spectra ....................................................................................................................... 40
     2.9.1 Alcohol dehydrogenase ...................................................................................................... 40
     2.9.2 Bovine serum albumin ........................................................................................................ 41
     2.9.3 Cytochrome C ...................................................................................................................... 42
     2.9.4 Lysozyme ............................................................................................................................ 43
     2.9.5 Vitamin B12 ......................................................................................................................... 44
     2.9.6 Tris(ethylenediamine) cobalt chloride .............................................................................. 45
     2.9.7 Camphor sulphonic acid ..................................................................................................... 46
     2.9.8 (R)-3-methylcyclopentanone .............................................................................................. 47
  2.10 Troubleshooting .................................................................................................................... 48

3 HARDWARE .................................................................................................................................. 49
  3.1 The spectrometer layout .......................................................................................................... 49
  3.2 Electrical connections .............................................................................................................. 49
     3.2.1 Mains connections .............................................................................................................. 49
     3.2.2 Module connections ............................................................................................................. 50
3.3 Nitrogen purge gas connections ................................................................. 51
3.4 Light source ................................................................................................. 51
  3.4.1 General ..................................................................................................... 51
  3.4.2 Standard xenon lamp .............................................................................. 52
  3.4.3 Mercury – xenon lamp .......................................................................... 52
  3.4.4 Ozone-free xenon lamp .......................................................................... 52
  3.4.5 Lamp removal and replacement .............................................................. 53
3.5 The Spectrometer Sample Handling Unit (ESHU) ......................................... 54
3.6 Detectors ....................................................................................................... 55
  3.6.1 CD detector options ............................................................................... 55
  3.6.2 Removal and replacement ..................................................................... 55
3.7 Maintenance .................................................................................................. 57
3.8 Moving the spectrometer ............................................................................ 57
  3.8.1 Parking the monochromator ................................................................... 57
  3.8.2 Lifting and moving the spectrometer ..................................................... 57
4 PRO-DATA CHIRASCAN .................................................................................. 58
  4.1 The Spectrometer Control Panel ................................................................. 58
  4.2 The Signal panel .......................................................................................... 59
    4.2.1 General ................................................................................................ 59
    4.2.2 The Signal panel for Circular dichroism ............................................ 60
    4.2.3 The Signal panel for Absorbance ....................................................... 62
    4.2.4 The Signal panel for Voltage ............................................................ 63
  4.3 The Shutter / attenuator panel ..................................................................... 63
  4.4 The Monochromator panel .......................................................................... 64
    4.4.1 General ................................................................................................ 64
    4.4.2 Advanced mono setup: discrete wavelengths .................................... 65
    4.4.3 Advanced mono setup: skip-scans ..................................................... 65
  4.5 The Trigger and Timebase Panels ............................................................... 66
  4.6 The Sampling panel ..................................................................................... 66
  4.7 The Sequencer panel ................................................................................... 68
  4.8 The Progress and Status panel ................................................................... 68
  4.9 The Temperature Control Unit panel .......................................................... 69
  4.10 The Sample Handling Unit panel (ESHU) panel ....................................... 69
  4.11 Toolbar icons ............................................................................................ 71
  4.12 Drop-down menus .................................................................................... 72
    4.12.1 The File menu .................................................................................. 72
    4.12.2 The View menu .............................................................................. 72
    4.12.3 The Configuration menu ................................................................... 73
    4.12.4 The Help menu ................................................................................ 73
  4.13 The Device window .................................................................................... 74
    4.13.1 General ............................................................................................. 74
    4.13.2 Mono1 ............................................................................................. 75
    4.13.3 The attenuator .................................................................................. 76
    4.13.4 The circular dichroism DC channel ................................................. 77
    4.13.5 Device icons requiring accessories ................................................. 78
  4.14 The Preferences dialog box ........................................................................ 79
    4.14.1 The Viewer tab ................................................................................ 79
    4.14.2 The CD tab ..................................................................................... 79
    4.14.3 The Absorbance tab ......................................................................... 80
    4.14.4 The Fluorescence tab ....................................................................... 80
4.15 Recalibrating the Chirascan .................................................. 82
4.15.1 Recalibrating the CD ....................................................... 82
4.15.2 Recalibrating the derived absorbance (Chirascan only) .......... 83

5 PRO-DATA VIEWER ................................................................. 85
5.1 Introduction ........................................................................... 85
5.1.1 Launching Pro-Data Viewer ............................................... 86
5.1.2 File structure: the Datastore .............................................. 86
5.1.3 Viewing experimental conditions ....................................... 87
5.2 Displaying and selecting data .................................................. 87
5.2.1 The graphical display ....................................................... 87
5.2.2 Selecting a spectrum in the display ..................................... 88
5.2.3 Selecting more than one spectrum .................................... 89
5.2.4 Zooming and re-scaling the display using the mouse ......... 89
5.2.5 Displaying different properties .......................................... 90
5.3 Manipulating, Fitting and Converting data ............................... 91
5.3.1 Trace Manipulation .......................................................... 91
5.3.2 Curve Fitting ................................................................... 95
5.3.3 Converting CD Units ........................................................ 96
5.3.4 Saving data ...................................................................... 97
5.4 Exporting data ...................................................................... 97
5.5 Handling multi-dimension Datastores ........................................ 98
5.5.1 Loading multi-dimension Datastores ................................... 98
5.5.2 Changing the display axes .................................................. 99
5.5.3 Mining multi-dimension Datastores .................................... 100
5.6 Pro-Data Viewer toolbar icons ................................................ 101
5.6.1 Launchpad toolbar icons .................................................. 101
5.6.2 Graphical display toolbar icons ......................................... 102
5.7 Launchpad drop-down menus .................................................. 103
5.7.1 The File menu ................................................................. 103
5.7.2 The View menu ............................................................... 103
5.7.3 The Directory menu ........................................................ 104
5.7.4 The Preferences window .................................................. 104
5.7.5 The Help menu ............................................................... 105
5.8 Graphical Display drop down menus ....................................... 106
5.8.1 The File menu ................................................................. 106
5.8.2 The View menu ............................................................... 106
5.8.3 The Trace menu .............................................................. 107
5.8.4 The Math menu .............................................................. 108
5.8.5 The Scale menu .............................................................. 108
5.8.6 The Window menu ........................................................ 109
5.8.7 The Help menu ............................................................... 109
5.9 CD background subtraction theory ............................................ 110
5.10 Using CDNN to calculate the secondary structure of proteins .... 113
5.10.1 Getting started ............................................................... 113
5.10.2 Using CDNN with your own results ................................. 115
5.10.3 Dealing with uncharacterised proteins .............................. 118

6 TECHNICAL OVERVIEW .......................................................... 119
6.1 Key technical features

6.1.1 The subsystems
6.1.2 Optical train
6.1.3 The LAAPD detector (Chirascan-plus only)
6.1.4 Control and acquisition electronics

6.2 Chirascan Windows software

6.2.1 Signal processing
6.2.2 Application software architecture

6.3 Simultaneous calculation of absorbance and CD

6.3.1 Introduction
6.3.2 Absorbance measurement

6.4 Adaptive sampling

6.4.1 Introduction
6.4.2 The AutoPM function
6.4.3 The adaptive sampling algorithm

6.5 Data filtering

6.5.1 Introduction
6.5.2 Electronic filtering
6.5.3 Signal Averaging
6.5.4 Cosmetic smoothing

6.6 References
FIGURES

Figure 1.1: the Chirascan-plus spectrophotometer ..................................................20
Figure 2.1: the purge gas manifold gas flow controllers ...........................................22
Figure 2.2: the system panel ....................................................................................24
Figure 2.3: the lamp panel .......................................................................................24
Figure 2.4: the Pro-Data SCP ..................................................................................25
Figure 2.5: the signal panel in the Pro-Data interface ...............................................26
Figure 2.6: Monochromator panel in the Pro-Data interface ...................................26
Figure 2.7: Sampling panel in the Pro-Data interface ...............................................27
Figure 2.8: Background CD spectrum .....................................................................28
Figure 2.9: the File Names dialog box .....................................................................28
Figure 2.10: CD spectrum of lysozyme (raw data) ..................................................29
Figure 2.11: Pro-Data Viewer, showing the launchpad (left) and graphical display (right) ...........30
Figure 2.12: CD spectrum of lysozyme (raw data) ..................................................30
Figure 2.13: the Windows dialog box ......................................................................31
Figure 2.14: Raw data with dialog box called up ......................................................32
Figure 2.15: an appropriate smooth (left) and an inappropriate one (right) .................33
Figure 2.16: Trace manipulation dialog box after spectrum manipulation ....................34
Figure 2.17: smoothed and background corrected spectrum of lysozyme (red) and smoothing residuals (cyan) 34
Figure 2.18: the Datastore History ..........................................................................35
Figure 2.19: File manipulation pop-up menu ............................................................35
Figure 2.20: options for exporting data .....................................................................36
Figure 2.21: the APLDataConverter target ..............................................................36
Figure 2.22: the APLDataConverter Option dialog box ...........................................37
Figure 2.23: CD spectrum of alcohol dehydrogenase ..............................................40
Figure 2.24: CD spectrum of bovine serum albumin ...............................................41
Figure 2.25: CD spectrum of cytochrome C .............................................................42
Figure 2.26: CD spectrum of lysozyme ....................................................................43
Figure 2.27: CD spectrum of vitamin B12 ..............................................................44
Figure 2.28: CD spectrum of tris(ethylene diamine) cobalt chloride .........................45
Figure 2.29: CD spectrum of camphor sulphonic acid ............................................46
Figure 2.30: CD spectrum of (R)-3-methylcycloptaneone ........................................47
Figure 3.1: the spectrometer layout ........................................................................49
Figure 3.2: mains electricity connections ................................................................50
Figure 3.3: the purge gas inlet connection on the rear of the ESHU .........................51
Figure 3.4: the lamp panel .......................................................................................52
Figure 3.5: lamp housing fittings ...........................................................................53
Figure 3.6: the interior of the spectrometer Sample Handling Unit .............................54
Figure 3.7: the interior of the ESHU, viewed from the right (one thumbscrew is obscured by the fluorescence detector locking ring) ........................................................................55
Figure 3.8: detector fitted with window cover ..........................................................55
Figure 3.9: the CD detector in position in the ESHU ...............................................56
Figure 3.10: the Monochromator dialog box ............................................................57
Figure 4.1: the Spectrometer Control Panel ............................................................58
Figure 4.2: the Signal panel .....................................................................................59
Figure 4.3: the Live Signal display ..........................................................................59
Figure 4.4: the Signal panel with Circular Dichroism selected ................................60
Figure 4.5: the Quickview – CD background dialog box .........................................61
Figure 4.6: the Signal panel with Absorbance selected ...........................................62
Figure 4.7: the Signal panel with Voltage selected ................................................................. 63
Figure 4.8: the Shutter / Attenuator panel ............................................................... 63
Figure 4.9: the Monochromator panel ............................................................................. 64
Figure 4.10: the Monochromator Scan Setup - Advanced dialog box ......................... 65
Figure 4.11: the Trigger and Timebase panels ................................................................. 66
Figure 4.12: the Sampling panel ....................................................................................... 66
Figure 4.13: the Sampling – Advanced dialog box ............................................................ 67
Figure 4.14: the Disable oversampling warning message .................................................. 67
Figure 4.15: the Sequencer panel ...................................................................................... 68
Figure 4.16: the Progress and Status panel ....................................................................... 68
Figure 4.17: the Temperature Control Unit panel ............................................................ 69
Figure 4.18: the Sample Handling Unit panel ................................................................. 69
Figure 4.19: the Sample and Cell description dialog box ................................................... 70
Figure 4.20: the SCP Toolbar ......................................................................................... 71
Figure 4.21: the File menu ............................................................................................... 72
Figure 4.22: the View menu ............................................................................................. 72
Figure 4.23: the Configuration menu ................................................................................ 73
Figure 4.24: the Select SHU dialog box ........................................................................... 73
Figure 4.25: the Help menu ............................................................................................. 73
Figure 4.26: the Device window ....................................................................................... 74
Figure 4.27: the Monochromator window ...................................................................... 75
Figure 4.28: the Attenuator / Shutter Control window ...................................................... 76
Figure 4.29: the CD DC photometric Channel window ................................................... 77
Figure 4.30: the Viewer tab ............................................................................................. 79
Figure 4.31: the CD tab .................................................................................................. 79
Figure 4.32: the Absorbance tab ..................................................................................... 80
Figure 4.33: the Fluorescence tab ................................................................................... 80
Figure 4.34: the Data Acquisition tab .............................................................................. 81
Figure 4.35: the File Names tab ...................................................................................... 81
Figure 4.36: the Startup Preferences tab ......................................................................... 82
Figure 4.37: the CD calibration dialog box ..................................................................... 83
Figure 5.1: Pro-Data Viewer, showing the launchpad, left, and graphical display, right ................................................................. 85
Figure 5.2: the Datastores Details View ........................................................................ 87
Figure 5.3: two files selected in the launchpad and dragged onto the display ............... 88
Figure 5.4: CD spectrum of lysozyme with background selected ......................... 89
Figure 5.5: full display (left) and zoom using the left mouse button (right) ................... 90
Figure 5.6: zoom using wheel alone (left), Ctrl + wheel (centre), ................................. 90
Figure 5.7: example menu of properties that can be plotted as y-axis ......................... 90
Figure 5.8: absorbance spectra for water (red) ................................................................. 91
Figure 5.9: the Trace Manipulation dialog box ................................................................. 92
Figure 5.10: raw data with dialog box called up .............................................................. 92
Figure 5.11: An appropriate smooth (left) and an inappropriate one (right) .............. 93
Figure 5.12: Trace manipulation dialog box after spectrum manipulation ................. 94
Figure 5.13: smoothed and background corrected spectrum of lysozyme (red) and smoothing residuals (blue) ................................. 94
Figure 5.14: hydrolysis of glucuronolactone with potassium hydroxide .................. 95
Figure 5.15: the Convert CD units dialog box ................................................................. 96
Figure 5.16: converting to a normalized unit ................................................................. 97
Figure 5.17: File manipulation pop-up menu ................................................................ 97
Figure 5.18: options for exporting data ......................................................................... 98
Figure 5.19: Stepped temperature-ramp showing first cell CD spectra ....................... 98
Figure 5.20: the dimension menu ........................................................................................................... 99
Figure 5.21: CD spectrum for each of the four cells at 20°C .................................................................. 99
Figure 5.22: Decompose Data dialog box .................................................................................................. 100
Figure 5.23: Decompose data dialog box ................................................................................................. 100
Figure 5.24: the Decompose data dialog box for a 3-dimension Datastore .............................................. 100
Figure 5.25: the launchpad toolbar ........................................................................................................... 101
Figure 5.26: the graphical display toolbar .................................................................................................. 102
Figure 5.27: the File menu ......................................................................................................................... 103
Figure 5.28: the View menu ....................................................................................................................... 103
Figure 5.29: the Directory menu .............................................................................................................. 104
Figure 5.30: the Preferences menu ........................................................................................................... 104
Figure 5.31: the Connect dialog box ......................................................................................................... 105
Figure 5.32: the Connection error message ............................................................................................... 105
Figure 5.33: the Help menu ....................................................................................................................... 105
Figure 5.34: the File menu ......................................................................................................................... 106
Figure 5.35: the View menu ....................................................................................................................... 106
Figure 5.36: the Trace menu ...................................................................................................................... 107
Figure 5.37: the Math menu ...................................................................................................................... 108
Figure 5.38: the Scale menu ..................................................................................................................... 108
Figure 5.39: the Window menu ................................................................................................................ 109
Figure 5.40: the Help menu ..................................................................................................................... 109
Figure 5.41: multiple lysozyme spectra ................................................................................................... 110
Figure 5.42: smoothing residuals (left) and their average (right) ............................................................. 111
Figure 5.43: single-background-corrected residuals (left) and their average (right) .............................. 111
Figure 5.44: single, smoothed-background-corrected residuals (left) and their average (right) .............. 112
Figure 5.45: the Simple Spectra dialog box ............................................................................................. 113
Figure 5.46: the Sample Files folder ....................................................................................................... 113
Figure 5.47: the CD Signal Type dialog box ............................................................................................. 114
Figure 5.48: calculated components of the secondary structure of lysozyme ........................................... 114
Figure 5.49: Lysozyme and background spectra, several repeat measurements ................................... 115
Figure 5.50: Lysozyme spectrum, after averaging, background correction and smoothing .................. 116
Figure 5.51: the Save Selected Traces window ......................................................................................... 116
Figure 5.52: the CD Signal Type window .................................................................................................. 117
Figure 5.53: the Deconvolution window .................................................................................................. 117
Figure 5.54: the CD Signal Type dialog box for an uncharacterised protein ............................................ 118
Figure 6.1: Schematic of the relationship between the Chirascan subsystems ...................................... 119
Figure 6.2: schematic of the spectrometer optical train .......................................................................... 120
Figure 6.3: quantum efficiency of the LAAPD and PMT detectors ....................................................... 122
Figure 6.4: LAAPD amplifier gain and emulated HV value .................................................................... 122
Figure 6.5: noise variance against HV at constant DC target ............................................................... 130
Figure 6.6: relative sample size as a function of HV .............................................................................. 131
Figure 6.7: raw, smoothed and residual CD data ..................................................................................... 133
TABLES

Table 2.1: N₂ purge flow rates .................................................................................................................23
Table 2.2: maximum bandwidth at low wavelengths .................................................................................38
Table 2.3: recommended conditions for measuring protein CD spectra .....................................................39
Table 2.4: operating conditions for the spectrum in Figure 2.23 ................................................................40
Table 2.5: operating conditions for the spectrum in Figure 2.24 ................................................................41
Table 2.6: operating conditions for the spectrum in Figure 2.25 ..............................................................42
Table 2.7: operating conditions for the spectrum in Figure 2.26 ..............................................................43
Table 2.8: operating conditions for the spectrum in Figure 2.27 ..............................................................44
Table 2.9: operating conditions for the spectrum in Figure 2.28 ..............................................................45
Table 2.10: operating conditions for the spectrum in Figure 2.29 ............................................................46
Table 2.11: operating conditions for the spectrum in Figure 2.30 ............................................................47
Table 3.1: module labels for the standard configuration .......................................................................50
Table 4.1: conditions for CD calibration ..................................................................................................82
Table 5.1: operating conditions for the spectra shown in Figure 5.49 .........................................................115
1 INTRODUCTION

Circular dichroism (CD) is the difference in the absorbance of left-handed circularly polarised light (L-CPL) and right-handed circularly polarised light (R-CPL) and occurs when a molecule contains one or more chiral chromophores (light-absorbing groups), i.e.:

\[ \text{CD} = \Delta A(\lambda) = A(\lambda)_{\text{L CPL}} - A(\lambda)_{\text{R CPL}}, \]

where \( \lambda \) is the wavelength.

Circular dichroism (CD) spectroscopy is a spectroscopic technique where the CD of molecules is measured over a range of wavelengths. CD spectroscopy is used extensively to study chiral molecules of all types and sizes, but it is in the study of large biological molecules where it finds its most important applications. A primary use is in analysing the secondary structure or conformation of macromolecules, particularly proteins, and because secondary structure is sensitive to its environment, e.g. temperature or pH, circular dichroism can be used to observe how secondary structure changes with environmental conditions or on interaction with other molecules. Structural, kinetic and thermodynamic information about macromolecules can be derived from circular dichroism spectroscopy.

Measurements carried out in the visible and ultra-violet region of the electro-magnetic spectrum monitor electronic transitions, and, if the molecule under study contains chiral chromophores then one CPL state will be absorbed to a greater extent than the other and the CD signal over the corresponding wavelengths will be non-zero. A circular dichroism signal can be positive or negative, depending on whether L-CPL is absorbed to a greater extent than R-CPL (CD signal positive) or to a lesser extent (CD signal negative).

Circular dichroism spectra are measured using a circular dichroism spectrometer, such as the Chirascan, which is a highly specialised derivative of an ordinary absorption spectrometer. CD spectrometers measure alternately the absorption of L- and R-CPL, usually at a frequency of 50 kHz, and then calculate the circular dichroism signal.
From its launch in 2004, the Chirascan led the world in setting the standard for steady state circular dichroism spectroscopy. That lead was extended by the launch of the Chirascan-plus in 2006 which uses a large area photodiode (LAAPD) based detector with higher quantum efficiency than the photomultiplier tube (PMT) detector used on the standard Chirascan. Developed with innovative optical design features to maximise light throughput, particularly in the far ultraviolet (UV) wavelength region, and a digital data acquisition system that facilitates collection of accurate and precise spectra, the Chirascan and its sister instrument the Chirascan-plus are able to produce data unrivalled by any other commercially available circular dichroism spectrometer.
2 QUICK START

This Chapter describes the basic operation of the spectrometer, covering the start up of hardware and software, use of the spectrometer instrument control and data acquisition software to collect CD spectra and backgrounds, use of the graphics software to carry out common operations on the data and to save data appropriately, and conversion of data formats for export to third-party programs. More detailed information on these operations is given in Chapters 4 and 5 of this User Manual.

2.1 Purging

The interaction between ultraviolet light and oxygen leads to the formation of ozone, a very reactive gas that is damaging to health and may cause deterioration of the optical components of the instrument. If an ozone producing lamp is used, it essential that the spectrometer is thoroughly purged with nitrogen before the lamp is ignited.

Oxygen in the form of O$_2$ absorbs light in the far UV region of the spectrum, and its presence will reduce the wavelength range of the spectrometer. More importantly, the interaction between oxygen and UV light leads to the formation of ozone (O$_3$), which absorbs in the UV at higher wavelengths than oxygen, further reducing range of the instrument, and is also damaging to health and to some of the components of the instrument. If an ozone producing lamp is used, it is essential that the instrument is thoroughly purged with nitrogen before the lamp is ignited, and remains purged while the lamp is on.

It is also essential that the nitrogen used to purge the instrument is clean. A combined molecular sieve (13x) and activated charcoal filter is supplied with the instrument which removes from the nitrogen stream all common impurities, that could otherwise deposit on the internal optical surfaces. This filter should not be by-passed or removed.

After passing through the filter, the nitrogen is distributed to the instrument via a manifold containing three gas flow controllers (Figure 2.1). The gas pressure regulator of the master supply should be set in the range 4 to 6 bar (60 to 90 p.s.i.).

![Figure 2.1: the purge gas manifold gas flow controllers](image)

The three gas flow controllers (rotameters) control nitrogen flow to the lamp housing, monochromator and sample housing respectively, from left to right.
At first start-up, set the gas flow to 4 L/min, 10 L/min and 4 L/min for the lamp housing, monochromator and sample chamber respectively, and let the purge continue for at least 30 minutes before attempting to ignite the lamp (Section 2.2). After this initial high-flow purge, the controllers can be set at their normal operating flow rates of 1 L/min, 3 L/min and 1 L/min. The flow rates are summarized in Table 2.1.

<table>
<thead>
<tr>
<th></th>
<th>N₂ flow-rates (start-up) L/min</th>
<th>N₂ flow-rates (normal) L/min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lamp housing</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>Monochromator</td>
<td>10</td>
<td>3</td>
</tr>
<tr>
<td>Sample chamber</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>16</strong></td>
<td><strong>5</strong></td>
</tr>
</tbody>
</table>

Table 2.1: N₂ purge flow rates

Note that the maximum possible flow rate will be determined by the source pressure. If the pressure is significantly below the maximum 6 bar, then it might not be possible to achieve the listed flow rates. If that is the case, set the flow rates to the highest possible, directing the majority of flow through the monochromator.

The lamp housing and monochromator have slow vent points to allow the internal atmosphere to be displaced by nitrogen, which means that once the initial high-flow purge is complete, there should be no need to repeat the high flow-rate purge unless the purge has been interrupted for longer than a weekend. If the purge has not been interrupted for too long, resuming normal nitrogen flow for 30 minutes is usually sufficient to re-establish a fully purged light path.

2.2 Powering on

Ensure that the instrument is connected to the electricity supply and that it has been purged according to Section 2.1. Put the two black rocker switches (System and Lamp) on the front panels (Figure 2.2 and Figure 2.3) to the power on (I) position. The instrument will automatically check its zero positions (you may hear the monochromator motors moving). Ignite the lamp by pressing the red Start button on the lamp control panel no sooner than 10 seconds after the lamp has been powered on – this is to allow sufficient time for the capacitors to charge up. If ignition is successful, the translucent panel on the source housing adjacent to the control panel will glow yellow if a xenon lamp is fitted, or yellow/green if a mercury-xenon lamp is fitted; if you do not see a yellow or yellow/green glow, press the red Start button again; repeat until ignition is achieved. The lamp will require at least 15 minutes to stabilise following ignition. Finally, ensure that the computer, its monitor and printer are all powered on.
Once the lamp is struck, it is strongly recommended that it be left on for the duration of the work planned for the
day. Repeated powering on and powering off will lead to instabilities (see previous paragraph) and will reduce
the life of the lamp. However, if it is necessary to restart the lamp after running, it must be allowed to cool for
about 15 minutes before re-ignition is attempted.

The light-emitting diodes (LED’s) on the System panel (Figure 2.2) are labelled Status, Tx and Rx; Tx and Rx will
illuminate when commands are being transmitted or data is being received respectively; the green Status LED
should be constantly illuminated. If it is flashing, it indicates that one or more of the electronics self-tests has
failed. If this happens, try restarting the electronics and if the problem persists, please contact APL technical
support.

The red LED on the lamp panel (Figure 2.3) indicates that power is present. The digital timer records the number
of hours that the lamp has been running; adjacent to the timer is a recessed reset button: the timer should be
reset when the lamp is changed.
On shut-down, it is recommended that only the lamp is extinguished, by setting the black rocker switch to the off (O) position. The electronics can be left powered on quite safely. Once the lamp is extinguished, the nitrogen should be left on for a few minutes while the lamp cools.

2.3 Launching the software

On starting the computer, among other icons on the desktop, you will see two associated with the Chirascan and . These are named Chirascan and Pro-Data Viewer respectively. Double-click on the Chirascan icon to launch the Pro-Data Spectrometer Control Panel (SCP), Figure 2.4.

The Pro-Data interface enables you to configure the instrument and to manage experiments. It is divided into a number of panels, **Signal**, **Temperature Control Unit**, **Sample Handling Unit**, **Monochromator**, **Sampling**, **Sequencer** and **Progress and Status**, in which are grouped the parameters relevant to the control or management of that panel’s function. In addition, there is an unlabelled panel for controlling shutter function and detector high voltage.
2.4 Measuring a CD background and spectrum

When a sample is placed into the sample chamber, it is inevitable that a small quantity of air will be introduced to the low-volume light path within the chamber. It takes only a few seconds to re-establish an air-free environment and you should not need to wait longer than that before starting your measurement.

2.4.1 The CD background

Every CD spectrometer has a CD background, caused by the interaction of circularly polarized light (CPL) with the slight birefringence found in the PMT detector window and to a lesser extent in the cuvette. To see the true CD spectrum of your sample, this background must be measured and subtracted from the CD spectrum of the sample.

To measure the CD background, you must measure the CD spectrum of a blank. The blank must be identical in every way to the sample that you want to measure, except that the sample itself is absent. For example, if you intend to measure an aqueous solution of lysozyme in a 0.2 mm pathlength rectangular cuvette, then the CD background is determined using the same cuvette containing only water.

On the Signal panel (Figure 2.5), there is a drop-down menu that contains the main data collection modes: select Circular Dichroism. In Options, select either delta A (delta absorbance) or millidegrees, as the units in of CD. Select Absorbance if you wish make a simultaneous measurement of the absorbance spectrum of the sample (Circular Dichroism, millidegrees and Absorbance are selected by default).

Set the lower and upper wavelength limits of the scan range for your experiment on the Monochromator panel of the Pro-Data interface Figure 2.6); these will normally be the same for both CD background and CD spectrum. For example, you might set Low to 180 nm and High to 260 nm for a typical protein. Set the wavelength step...
size in **Step**, typically 1 nm or less, and click **Set**. To the left of the monochromator wavelength bar, set the required bandwidth. Typically, a bandwidth of 1 nm is suitable for protein CD spectroscopy.

<table>
<thead>
<tr>
<th>Sampling</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.5000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time-per-point(s)</td>
<td>0.5000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Time-per-point(s)</td>
<td>0.5000</td>
<td>73 seconds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>73 seconds</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enable Adaptive Sampling</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 2.7: Sampling panel in the Pro-Data interface**

On the **Sampling** panel (Figure 2.7), set the time-per-point to the desired value. An approximate scan-time is shown, which is equal to the product of the time-per-point and the scan range divided by the step size. In general, the longer the scan-time the better the data quality, but the chosen scan-time will be a compromise between data quality and experimental duration.

Once the experimental details have been set, with the blank in place in the sample holder, go to the **Signal** panel and click **Background**. A CD background will now be measured; the display and data manipulation program Pro-Data viewer will automatically start and the data will be displayed; the data are stored as a file called Backgroundxxxx.ds (unless a different seed name has been specified – see later in this Section) in your default working directory. The **Auto Subtraction** check box becomes active at the conclusion of a background scan: if you wish to subtract the background automatically from subsequently measured CD spectra, tick the **Auto Subtraction** check box.

Note that if Pro-Data viewer has been launched from the desktop independently of Pro-Data itself by clicking on its desktop icon, then Pro-Data will not know of the existence of the Viewer, which is a separate program, and Pro-Data viewer will not respond to the start of an experiment in the normal way. To make the connection between the programs, go to **Preferences>Go online**… in Pro-Data Viewer and select **Local** in the dialog box.

In general, when working at the instrument, it is recommended that you launch Pro-Data Viewer from Pro-Data Chirascan using the **icon in the toolbar. This will ensure that local communication is established, that Pro-Data viewer will work correctly as a real-time display and that the data will be saved to a Datastore in the current working directory.
An example of a background CD spectrum is shown in Figure 2.8. You do not need to use the default name for the background: you can specify a seed name by clicking on the File Names icon in the toolbar of the Pro-Data interface or selecting Configuration>Preferences>File Names (Section 4.14.6), and specifying seed names for the backgrounds and spectra (Figure 2.9).

2.4.2 The CD spectrum
Once you have measured the CD background, replace the blank with your sample. As the conditions for the measurement of the sample will be identical to those for the blank, go straight to the Spectrum panel of the SPC and click Acquire. The CD spectrum will be recorded under the conditions applied to the blank and stored as a file called Spectrumxxxx.dsx, unless you have specified a different seed name (Section 4.14.6)
The program Pro-Data viewer will automatically display the data as it is collected; an example is given in Figure 2.10. Double-clicking anywhere on the plot will autoscale the display.

When any CD spectrum is measured on Chirascan, other properties are simultaneously recorded. These include the voltage applied to the detector, the temperature and the absorbance spectrum (if selected on the Options panel). They can be viewed by right-clicking on the y-axis variable.

2.5 Viewing and manipulating spectra

If you have just measured a CD spectrum, Pro-Data Viewer will be running and the CD spectrum will be displayed. If Pro-Data Viewer is not running, launch it using the icon in the Pro-Data SCP toolbar or, if the Pro-Data SCP is not running either, from the desktop icon. The program will open at the current working directory. You can change the location of the working directory by selecting or creating a different folder and using the Set Working Directory option on the Directory menu (Section 5.7.3). The working directory is where new spectra will be saved.
2.5.1 Viewing spectra

With the Datastores Explorer open, navigate in the usual way until you find the file of interest and double click on it. Pro-Data viewer displays the data contained in the file (Figure 2.12).

![Figure 2.12: CD spectrum of lysozyme (raw data)](image)

Double-click the left mouse button anywhere on the graphical display to autoscale the axes such that you see the full spectrum. To zoom in to a particular part of the display, click and hold the left mouse button whilst moving the cursor to create a box around the area of interest. On releasing the left mouse button, the newly-created box will
expand to fill the display window. To return to the original display, simply double-click the left mouse button at any time.

To zoom in or out in both x- and y-axes simultaneously, use the mouse-wheel; to zoom in or out in the x-axis only, use Ctrl in conjunction with the mouse-wheel; to zoom in or out in the y-axis, use Shift in conjunction with the mouse-wheel.

To view the other properties measured simultaneously with the CD spectrum, right-click on the y-axis label and choose the property from the dropdown list that appears, or select New Window on the Windows menu (Figure 2.13).

2.5.2 Comparing spectra

If you wish to compare spectra, drag-and-drop the files of interest onto the graphical display window from the Datastore Explorer. More than one spectrum at a time can be dragged, using the usual combinations of Ctrl, Shift and mouse buttons. The spectra will be displayed in a single window. Note that the data sets must be compatible – you cannot overlay a trace collected as a function of wavelength with one that was collected as a function of some other variable, such as temperature.

2.5.3 Manipulating spectra

In the example below, there are six traces (3 repeat backgrounds and 3 repeat lysozyme spectra). The data used in this example can be found in The Examples\Lysozyme spectra folder in C:\Program files\Applied Photophysics\Chirascan. We will average the backgrounds, average the spectra, subtract the average background from the average spectrum, smooth the resulting background-corrected lysozyme spectrum and remove the original data. The end result will show the lysozyme spectrum and its residual (calculated minus observed spectrum).

With the data loaded into the display as previously described and the display window active, click on to call up the Trace manipulation dialog box (Figure 2.14).
The first three files are backgrounds; the second set of three are the lysozyme spectra.

Select the first group of three files and click **Average**.
Select the second group of three files and click **Average**.

Two files named AVERAGE xxxxxxxxxx with the identifying numbers taken from the computer timer will be added to the **Visible Traces** list and plotted in the display. The first of these will be the average of the backgrounds, and the second the average of the lysozyme spectra.

Select the first AVERAGE file and click **Set Background**.
Select the second AVERAGE file and click **Subtract Background**.
The file SUBTRACTED……………. (background subtracted spectrum) will be added to the **Visible traces** list and plotted in the display.

Select the SUBTRACTED……………. file and click on **Smooth**. The **Smoothing** dialog box will appear (Figure 2.15)
Enter the number of degrees of smoothing required in the **Window Size** box. This value will depend on the step resolution used during the measurement and the sharpness of the features in the spectrum. The number should be as large as is possible without causing distortion of the spectrum. Examination of the residual plot will show if any distortion has occurred. If the noise is randomly distributed about zero, the smoothing process has not caused any distortion and, importantly, you have the evidence to prove it.

An example of an appropriate smooth, in which 5 degrees of smoothing were used, and an inappropriate one, in which 12 degrees of smoothing were used on the same data set, are shown in Figure 4.8. The structure in the residuals that arises when 12 degrees of smoothing were used indicates that the spectrum has been oversmoothed.

When you are satisfied with the smoothing process, click **OK**.

Click **Unset Background**.

Select Smooth (s)…………….. and Smooth (r)…………….. and click **Remove Others**. The Trace manipulation dialog box will appear as in Figure 2.16.
Click **OK** to close the dialog box. The result of the above manipulation is shown in Figure 2.17, with the smoothed and background corrected spectrum of lysozyme and the smoothing residuals plotted.

Note that even when the **Trace Manipulation** dialog box is closed, any removed traces are remembered. Should you wish to carry out further manipulation, simply re-open the dialog box and all the traces will be listed, whether visible or removed, enabling you to carry on where you left off.
2.6 Saving, exporting and converting data

2.6.1 Saving data

If you have performed operations in Pro-Data Viewer (e.g. smoothing, averaging or background subtraction), added comments, or altered the data in any other way, you may want to save the results of the manipulation.

The manipulated data are not saved automatically. To save the result, go to File>Save Current Plot... (keyboard shortcut Shift+S) to call up the Save As... dialog box or File>Save selected traces (Ctrl+Shift+S). The original raw data are never over-written. The results of any manipulation are stored in a new Datastore and a complete history of the manipulated traces is contained in the History of that Datastore, an example of which is shown in Figure 2.18. The file history can be viewed on the View menu on Pro-Data Viewer.

![Figure 2.18: the Datastore History](image)

2.6.2 Exporting data from Pro-Data Viewer

Right-click on a filename in Pro-Data viewer launchpad to display the File manipulation pop-up menu shown in Figure 2.19.

![Figure 2.19: File manipulation pop-up menu](image)
Select **Export data**... to bring up the dropdown list in Figure 2.20 and choose an appropriate format for export to another program.

![Export Data](image)

**Figure 2.20: options for exporting data**

CSV format is suitable for third-party programs such as Excel; other options relate to formats derived from other APL products.

### 2.6.3 Converting data for use with third-party programs

This icon is installed on your desktop and will start the APL data converter (Figure 2.21).

![APLDataConverter](image)

**Figure 2.21: the APLDataConverter target**

The APLDataConverter program can be used to convert multiple files to other formats. Start the program, click the icon to open the dialog box shown in Figure 2.22, set the required options, and close the dialog box. Select the files in their Windows folder, and drag them onto the APLDataConverter target. The created files will be saved in the same folder as the originals.
2.7 Printing

The **Print** icon in Pro-Data viewer will print the current Pro-Data viewer display.

2.8 Operating notes and hints

2.8.1 Selecting Step Size (SS)

The step size will determine the number of data points that make up a spectrum. For a given time-per-point, larger step sizes will reduce the overall scan time of an experiment but will also reduce the resolution of the spectrum; smaller step sizes will improve the resolution of a spectrum, but will increase the experimental time. An appropriate step size can be chosen using:

\[ \text{SS} = \frac{\text{FWHH}}{20}, \]

where FWHH refers to the full width at half height (in nm) of the narrowest peak in the spectrum. If this is unknown, typical settings are:

- samples in solution: \(0.2 \text{ nm} \leq \text{SS} \leq 1 \text{ nm}\)
- gas or vapour samples: \(0.1 \text{ nm} \leq \text{SS} \leq 0.5 \text{ nm}\)

Examples are given in Section 2.9. Note that the analysis of protein spectra using the public domain software CDNN requires a 1 nm step size.
2.8.2 Selecting Spectral Bandwidth (SBW)

The spectral bandwidth should be selected to maximise the light reaching the sample, without overly compromising the spectral resolution. In general, the signal to noise ratio, S/N, is proportional to the square root of the light throughput, and the light throughput is proportional to the square of the bandwidth. Consequently, S/N is linearly proportional to the bandwidth. Doubling the bandwidth will reduce the noise level by a factor of 2, trebling the bandwidth will reduce the noise level by a factor of 3, and so on.

However, a wider bandwidth may result in some of the finer details of the spectrum being obscured, and there is limit to the maximum bandwidth that can be set. This varies with wavelength because of the non-linear dispersion of light by prisms: dispersion increases (and therefore maximum bandwidth decreases) with decreasing wavelength. The SBW ranges for the shorter wavelengths are given in Table 2.2.

<table>
<thead>
<tr>
<th>Wavelength</th>
<th>SBW range</th>
</tr>
</thead>
<tbody>
<tr>
<td>170 nm</td>
<td>0.1 nm ≤ SBW ≤ 3 nm</td>
</tr>
<tr>
<td>180 nm</td>
<td>0.1 nm ≤ SBW ≤ 4 nm</td>
</tr>
<tr>
<td>200 nm</td>
<td>0.1 nm ≤ SBW ≤ 6 nm</td>
</tr>
</tbody>
</table>

Table 2.2: maximum bandwidth at low wavelengths

The selected bandwidth is therefore a compromise between data quality and spectral resolution. Typical values are:

- samples in solution: 0.5 nm ≤ SBW ≤ 2 nm
- gas or vapour samples: 0.1 nm ≤ SBW ≤ 0.5 nm

Specific examples are given in Section 2.9.

2.8.3 Selecting pathlength and concentration

The pathlength and concentration of a sample should be chosen to optimize the light throughput to the detector. If the absorbance is too high, the light throughput will be too low for the detector to measure accurately; if the absorbance is too low, the detector will not be able to resolve the difference between the left and right circularly polarized signals accurately.

The optimal value for the absorbance when making CD measurements is about 0.87 absorbance units, AU, (≈ 14% light throughput). About 2.5 AU is usually the realistic upper limit for the absorbance (ideally it should not exceed about 2 AU). It is good practice to run a simultaneous absorbance scan when performing a CD experiment in order to verify that the absorbance is within the working range.

The absorbance can be adjusted by changing the concentration or pathlength, following the Beer-Lambert law:

\[ A \propto c.l \]

Where \( A \) is the absorbance, \( c \) is the concentration, and \( l \) is the pathlength (the proportionality constant depends on the sample).
2.8.4 Selecting the time-per-point

The time-per-point is the time taken for data sampling at each step. The longer the time taken, the better the signal to noise ratio; the selected time-per-point will therefore be a compromise between data quality and experimental duration.

In general the signal to noise ratio, S/N, is proportional to the square root of the time-per-point, thus doubling the time-per-point will reduce the noise level by a factor of \(2\), trebling the time-per-point will reduce the noise level by a factor by a factor of \(3\), and so on.

2.8.5 Measuring protein spectra.

Measuring the CD spectra of proteins is perhaps the most common use to which the Chirascan is put. The following paragraphs give some hints and tips on how to ensure that you your protein CD spectra are of the highest quality. It is not possible to cover all contingencies, but these guidelines should provide at least a starting point in helping you to find the optimal experimental conditions.

1. Use a short pathlength if measuring into the far UV.
2. Use a bandwidth \(\leq 1\) nm to ensure the detector is working within its linear regime, especially as you go to the near UV where samples absorb less light. With the sample in place, the detector high-voltage should not drop below 200 volts. If it does, reduce the bandwidth.
3. If you wish to go below 180 nm, consider using heavy water (D\(_2\)O): it absorbs less in this region than normal water and is not expensive: buy NMR-standard D\(_2\)O from a reputable supplier.
4. If you wish to go to 170 nm – and these are very difficult experiments to perform – you will have to employ a cell with a pathlength \(\leq 0.1\) mm and use heavy water.
5. Use degassed solvent to prevent bubble formation in the cell (and to remove oxygen).
6. Ensure the instrument is purged properly with nitrogen. The normal flow rates of lows of 1 L/min, 3L/min and 1L/min for the lamp, monochromator and sample chamber respectively will be perfectly adequate, but when working below 180 nm the spectrometer should be purged overnight.
7. It is a good idea to separate the absorbance of the cell plus solvent from that of sample. The best way to do this is to measure a background with no cell or sample in place, then measure the CD spectrum of a blank (cell plus solvent), and the total CD spectrum (cell plus solvent plus protein). Subtracting the blank contribution from the total will give you the CD and absorbance of the protein only. The reason for doing this, rather than simply using the cell plus solvent as the background, is that water – or buffer or D\(_2\)O – absorbs very strongly at wavelengths approaching and below 180 nm, and it is important that the total absorbance, rather than just that of the protein, is known so that it can be kept within the reasonable working range. If the total absorbance is below about 2 AU, or at most 2.5 AU, reasonable quality spectra should be obtainable.
8. Remember that light intensity at low wavelengths may cause photodegradation of the protein. Keep the bandwidth and the time-per-point as low as possible, commensurate with obtaining reasonable quality data. If there is any doubt, repeat the experiment to ensure that the results are reproducible, or perform a preliminary experiment to establish the timescale over which photodegradation occurs.

The recommended conditions are summarized in Table 2.3.

<table>
<thead>
<tr>
<th>Lower wavelength limit</th>
<th>Solvent</th>
<th>Pathlength</th>
<th>Protein concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>180 nm</td>
<td>H(_2)O, dilute buffer or D(_2)O</td>
<td>(\leq 0.5) mm</td>
<td>0.2 – 0.5 mg/ml</td>
</tr>
<tr>
<td>175 nm</td>
<td>H(_2)O or D(_2)O</td>
<td>(\leq 0.2) mm</td>
<td>0.5 – 1.0 mg/ml</td>
</tr>
<tr>
<td>170 nm</td>
<td>D(_2)O</td>
<td>(\leq 0.1) mm</td>
<td>1.0 mg/ml</td>
</tr>
</tbody>
</table>

Table 2.3: recommended conditions for measuring protein CD spectra
### 2.9 Example spectra

There are several files installed on the hard disk that can be used as templates to set up the Pro-Data interface or as tools to familiarise oneself with the use of Pro-Data viewer. The files are held in:

\[ \text{C:\ Program Files\ Applied Photophysics\ Chirascan\ Examples\} } \]

and can be accessed using the \( \text{icon} \) from the Pro-Data interface toolbar and in Pro-Data viewer by navigating to the directory in the launchpad.

#### 2.9.1 Alcohol dehydrogenase

The CD spectrum of alcohol dehydrogenase, plotted as CD (mdeg) against wavelength (nm) is shown in Figure \[ \text{2.23} \]. The operating conditions are given in Table \[ \text{2.4} \].

![CD spectrum of alcohol dehydrogenase](image)

**Figure 2.23: CD spectrum of alcohol dehydrogenase**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan range</strong></td>
<td>260 to 175 nm</td>
</tr>
<tr>
<td><strong>Spectral bandwidth</strong></td>
<td>1 nm</td>
</tr>
<tr>
<td><strong>Step size</strong></td>
<td>0.5 nm</td>
</tr>
<tr>
<td><strong>Pathlength</strong></td>
<td>0.1 mm</td>
</tr>
<tr>
<td><strong>Concentration</strong></td>
<td>1 mg/ml</td>
</tr>
<tr>
<td><strong>Solvent</strong></td>
<td>Water</td>
</tr>
<tr>
<td><strong>Time-per-point</strong></td>
<td>3 seconds</td>
</tr>
<tr>
<td><strong>Total N\text{_2} flow</strong></td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

**Table 2.4: operating conditions for the spectrum in Figure 2.23**
2.9.2 Bovine serum albumin

The CD spectrum of bovine serum albumin, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.24. The operating conditions are given in Table 2.5.

Figure 2.24: CD spectrum of bovine serum albumin

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>260 to 175 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>0.1 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>1 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>3 seconds</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

Table 2.5: operating conditions for the spectrum in Figure 2.24
2.9.3 Cytochrome C

The CD spectrum of cytochrome C, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.25. The operating conditions are given in Table 2.6.

![CD spectrum of cytochrome C](image)

**Figure 2.25:** CD spectrum of cytochrome C

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>260 to 175 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>0.1 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>1 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>3 seconds</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

**Table 2.6:** operating conditions for the spectrum in Figure 2.25
2.9.4 Lysozyme

The CD spectrum of lysozyme, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.26. The operating conditions are given in Table 2.7.

![CD spectrum of lysozyme](image)

**Figure 2.26: CD spectrum of lysozyme**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>260 to 185 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>2 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>0.5 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>0.2 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>1 s, 3 scan average</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

**Table 2.7: operating conditions for the spectrum in Figure 2.26**
2.9.5 Vitamin B12
The CD spectrum of vitamin B12, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.27. The operating conditions are given in Table 2.8.

![CD spectrum of vitamin B12](image)

**Figure 2.27: CD spectrum of vitamin B12**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>600 to 200 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>1 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>1 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>0.2 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>2 seconds</td>
</tr>
<tr>
<td>Total N(_2) flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

**Table 2.8: operating conditions for the spectrum in Figure 2.27**
2.9.6 Tris(ethylenediamine) cobalt chloride

The CD spectrum of tris(ethylene diamine) cobalt chloride, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.28. The operating conditions are given in Table 2.9.

![CD spectrum of tris(ethylene diamine) cobalt chloride](image)

Figure 2.28: CD spectrum of tris(ethylene diamine) cobalt chloride

<table>
<thead>
<tr>
<th>Scan range</th>
<th>800 to 250 nm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectral bandwidth</td>
<td>1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>1 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>10 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>1 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>0.5 seconds</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

Table 2.9: operating conditions for the spectrum in Figure 2.28
2.9.7 Camphor sulphonic acid
The CD spectrum of 1-S-camphor-10-sulphonic acid, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.9. The operating conditions are given in Table 2.10.

![CD spectrum of camphor sulphonic acid](image)

Figure 2.29: CD spectrum of camphor sulphonic acid

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>800 to 250 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>1 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>0.6 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Water</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>1.75 seconds</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

Table 2.10: operating conditions for the spectrum in Figure 2.29
2.9.8 (R)-3-methylecyclopentanone

The CD spectrum of (R)-3-methylecyclopentanone, plotted as CD (mdeg) against wavelength (nm) is shown in Figure 2.30. The operating conditions are given in Table 2.11.

![CD Spectrum Image]

Figure 2.30: CD spectrum of (R)-3-methylecyclopentanone

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan range</td>
<td>350 to 175 nm</td>
</tr>
<tr>
<td>Spectral bandwidth</td>
<td>0.1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.1 nm</td>
</tr>
<tr>
<td>Pathlength</td>
<td>10 mm</td>
</tr>
<tr>
<td>Concentration</td>
<td>Vapour</td>
</tr>
<tr>
<td>Solvent</td>
<td>-</td>
</tr>
<tr>
<td>Time-per-point</td>
<td>1 seconds</td>
</tr>
<tr>
<td>Total N₂ flow</td>
<td>5 L/min</td>
</tr>
</tbody>
</table>

Table 2.11: operating conditions for the spectrum in Figure 2.30
2.10 Troubleshooting

If the instrument does not operate properly, please use the following table to eliminate any trivial causes of incorrect function. There is also a 'frequently asked questions' section on the APL website (http://www.photophysics.com/faqch.php) to which you should refer if the table below does not help. If the symptoms persist, please contact Applied Photophysics Technical Support (contact details at front of manual) with a detailed description of your difficulty and the name of your spectrometer. Each spectrometer has a name that can be found on the front of the monochromator.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Corrective action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument / computer cannot be powered on.</td>
<td>No power available.</td>
<td>Check that all power cables are correctly plugged in and that the power at the mains outlet is powered on. Check that all supply fuses are intact.</td>
</tr>
<tr>
<td>No detector signal.</td>
<td>No light - lamp is not ignited.</td>
<td>Put the rocker switch in the ‘I’ (on) position and press the red ignite button.</td>
</tr>
<tr>
<td>No light - shutter is in the closed position.</td>
<td></td>
<td>Use the Pro-Data interface to Open the shutter.</td>
</tr>
<tr>
<td>No light – slits too narrow or closed.</td>
<td></td>
<td>Check the bandwidth in the Monochromator panel of the Pro-Data interface and set the bandwidth to a reasonable value, e.g. 1 nm</td>
</tr>
<tr>
<td>No HV on the detector.</td>
<td></td>
<td>In this case, light might be reaching the detector but without any high voltage applied to the detector there will be no signal. Check the detector cable is correctly connected and then use the Pro-Data interface to restore the HV.</td>
</tr>
<tr>
<td>No light – sample is opaque.</td>
<td></td>
<td>Reduce concentration and / or pathlength of sample and / or buffer.</td>
</tr>
<tr>
<td>No light in far UV – instrument is not purged.</td>
<td></td>
<td>Oxygen absorbs light at wavelengths below 190 nm. Ensure that the purge tubes are connected at both ends and that there is nitrogen available, and purge the instrument with clean nitrogen.</td>
</tr>
<tr>
<td>Signal is too noisy.</td>
<td>Bandwidth too narrow</td>
<td>Check the bandwidth in the mono section of the Pro-Data interface and set it to a reasonable value, e.g. 1 nm.</td>
</tr>
<tr>
<td>Sample or buffer is highly absorbing.</td>
<td></td>
<td>Reduce concentration and / or pathlength of sample and / or buffer.</td>
</tr>
<tr>
<td>Lamp is old.</td>
<td></td>
<td>If the lamp has been run for more than 1,000 hours, its output, especially in the far UV, will be low. Replace lamp.</td>
</tr>
<tr>
<td>Unstable line voltage</td>
<td></td>
<td>Use stabilised supply.</td>
</tr>
<tr>
<td>Electromagnetic interference from nearby equipment.</td>
<td></td>
<td>Remove the source of noise from the proximity of the spectrometer.</td>
</tr>
</tbody>
</table>
3 HARDWARE

This Chapter describes the Chirascan hardware, covering the general layout of the spectrometer, the electrical and purge gas connections, and the detectors and light sources available and their removal and replacement.

3.1 The spectrometer layout

The Chirascan series spectrometers comprise three main sections, as described in Chapter 1 of this User Manual and identified in Figure 3.1: the lamp housing on the left, the monochromator and electronics in the centre, and the Equilibrium Sample Handling Unit (ESHU) on the right. The lamp housing and monochromator / electronics sections have removable covers fitted, the ESHU is a self-contained unit that can easily be removed for transportation or to install the CS/SF stopped-flow unit.

3.2 Electrical connections

**WARNING**  The Chirascan series spectrometers are powered by the mains electricity supply which can produce a shock leading to serious injury or death. Do not connect or disconnect the instrument from the mains supply unless the supply is powered off at source. Exercise care during operation and do not operate units with their covers removed. The design of the spectrometer provides protection against electrical shock by earthing (grounding) appropriate metal components. This protection will be lost unless the power cable is connected to a properly earthed outlet. It is the user’s responsibility to ensure that a proper earth connection can be made.

3.2.1 Mains connections

The Chirascan has two electronics units mounted above the monochromator. When viewed from the rear of the spectrometer, the lamp electronics unit is to the right, the monochromator electronics unit to the left. Each unit requires a mains electricity supply at the local voltage (Figure 3.2).
3.2.2 Module connections

In its standard configuration, the Chirascan has four modules fitted in its electronics rack, labelled USB, PEM, CONTROL 1 and CONTROL 1 (Table 3.1) The two CONTROL 1 modules are distinguished by labelling their release buttons M1 and M2. The USB module has three connection ports, the others have two ports. Additional modules may be installed for accessories, for which see the relevant accessory User Manual.

<table>
<thead>
<tr>
<th>Module</th>
<th>USB MODULE</th>
<th>PEM MODULE</th>
<th>CONTROL MODULE 1</th>
<th>CONTROL MODULE 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper port</td>
<td>DRIVE</td>
<td>PEM</td>
<td>DRIVE 1</td>
<td>DRIVE 1</td>
</tr>
<tr>
<td>Lower port</td>
<td>TEMP INPUT</td>
<td>PMT (Chirascan) or LAAPD (Chirascan-plus)</td>
<td>DRIVE 2</td>
<td>DRIVE 2</td>
</tr>
<tr>
<td>Bottom port</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Release button</td>
<td></td>
<td></td>
<td>M1</td>
<td>M2</td>
</tr>
</tbody>
</table>

Table 3.1: module labels for the standard configuration

Some of the standard ports are used for internal connections, or are unused; others are for external connections.

The upper port on the USB module, labelled DRIVE, is currently unused, and is intended for future development. The lower port, labelled TEMP INPUT is a temperature read port: the connection cable splits, and goes partly to an internal connection and partly to the ESHU. If the ESHU is removed from the spectrometer it can be disconnected, but there is no need to remove the cable from the electronics rack. The bottom port is for the USB connection to the PC.

On the Chirascan, the lower port on the PEM module is for a PMT detector. This is normally a CD detector, but may be a fluorescence or fluorescence polarisation detector. On the Chirascan-plus, the port is for an LAAPD CD detector only.

The lower port on CONTROL module M2, labelled DRIVE 2, connects to the emission monochromator of the CS/SEM accessory.

The remaining ports are for internal connections.
3.3 Nitrogen purge gas connections

The reasons for purging the spectrometer with nitrogen when using an ozone producing lamp, and settings for the purge gas flow rates are described in Section 2.1 of this User Manual.

After passing through an 13x molecular sieve and activated charcoal filter, the purge gas is split three ways by a manifold, to provide separate supplies to the lamp housing, monochromator and ESHU. The flow rate for each supply is set at the manifold, as described in Section 2.1.

It is not normally necessary to disconnect the supply to the lamp housing and monochromator, except when moving the spectrometer, but if the ESHU is to be removed, the supply to the ESHU first should be disconnected, as follows:

1. Ensure that there is no purge gas flow to the ESHU
2. Unscrew the compression fitting nut connecting the purge gas supply line to the rear of the ESHU (Figure 3.3).
3. Withdraw the stainless steel supply line and move it away from the ESHU, taking care not to kink the line.

![Purge gas inlet](image)

Figure 3.3: the purge gas inlet connection on the rear of the ESHU

3.4 Light source

3.4.1 General

![WARNING]

The spectrometer is equipped with a light source (150 watt xenon or mercury-xenon arc lamp) that produces intense ultraviolet radiation that can irritate the eyes and may impair eyesight. Never look directly at the light source. Do not open the lamp housing while the lamp is operating or immediately after it is powered off. Do not allow the skin to be exposed to UV radiation.

The spectrometer uses an air-cooled, 150 watt xenon (Xe) or mercury-xenon (Hg-Xe) arc lamp as a light source. The housing is designed for the lamp to be easily removed and replaced, without the need for realignment or refocusing.
The performance of xenon arc lamps shows some deterioration over time. It is recommended that the lamp is replaced after 1000 hours of use.

The spectrometer lamp panel contains a timer showing the number of hours of lamp operation since the last reset (Figure 5.4). The counter can be reset using an object such as a 2 mm Allen key (hex key). It is recommended that the timer is reset when a new lamp is installed.

If it is intended to swap between lamps, for example when operating with or without an CS/SF stopped-flow unit, a record should be kept of the number of hours for which each lamp is in use.

Details of the lamps available for use with the Chirascan series spectrometers are described in Sections 3.4.2 to 3.4.4 of this manual.

![Figure 3.4: the lamp panel](image)

3.4.2 Standard xenon lamp
The standard light source used with the spectrometer is a 150 watt xenon arc lamp. The low wavelength radiation produced by this lamp is responsible for the conversion of oxygen to ozone, and this lamp should only be used with nitrogen purging. This lamp is not suitable for use with the CS/SF stopped flow accessory.

3.4.3 Mercury – xenon lamp
A mercury-xenon lamp is preferred to the standard xenon lamp for use with the CS/SF stopped-flow accessory, owing to its greater stability and higher output at specific wavelengths. The low wavelength radiation produced by this lamp is responsible for the conversion of oxygen to ozone, and this lamp should only be used with nitrogen purging. For more information on the use of this lamp, see the CS/SF User Manual.

3.4.4 Ozone-free xenon lamp
A non-ozone producing xenon lamp is also available. The low wavelength radiation responsible for the conversion of oxygen to ozone is filtered from the lamp output, removing the need for nitrogen purging, but limiting the low wavelength end of the range of the lamp to about 230 nm.
3.4.5 Lamp removal and replacement

**WARNING**  
The xenon arc lamp operates at mains voltage. Power off the lamp before removal.

**WARNING**  
Xenon arc lamps have a high internal pressure and can burst, particularly when hot, causing injury to the user. Handle carefully, do not submit the lamp to shock, and wear eye and face protection. Do not touch the glass bulb of the lamp with bare hands.

**WARNING**  
The lamp is at high temperature during operation. After powering off, allow at least 30 minutes to cool before removing the lamp.

To change a lamp, follow the steps below, referring to Figure 3.5.

1. Have an empty lamp storage box ready to receive the old lamp.
2. Power off the lamp, and leave for at least 30 minutes for the lamp to cool down.
3. Remove the spectrometer end cover by sliding it to the left, off the magnetic catches and clear of the lamp housing.
4. Unplug the red and black leads at the back of the lamp power supply.
5. Unscrew the two retaining screws on top of the lamp assembly.
6. Carefully lift the old lamp out of the housing and place in the storage box, securing with the retaining screws.
7. Unscrew the retaining screws from the new lamp storage box, remove the lamp, and carefully insert into the housing.
8. Secure the lamp in the housing with the retaining screws.
9. Reconnect the red and black leads, and replace the spectrometer end cover.
10. Purge the lamp housing at 5 litres per minute for at least 10 minutes, then reduce the flow to normal operational level.
11. Power off the lamp, wait for about 10 seconds, then strike the lamp and reset the timer on the lamp supply.
12. Please return the old lamp assembly to APL for recycling.

![Figure 3.5: lamp housing fittings](image)
3.5 The Spectrometer Sample Handling Unit (ESHU)

The spectrometer Equilibrium Sample Handling Unit (ESHU) is the lidded chamber that mounts to the right of the monochromator unit, where it is held in place by four thumbscrews. The ESHU can easily be removed from the spectrometer for transportation or to install the CS/SF stopped-flow accessory.

![Diagram of the ESHU](image)

**Figure 3.6: the interior of the spectrometer Sample Handling Unit**

The interior of the ESHU is shown viewed from the front with the lid raised in Figure 3.6 (the aperture for light inlet from the monochromator is to the left, opposite the CD detector port).

There are two detector ports on the ESHU, to the right and rear. Normally the right port is used for CD and the rear port for fluorescence. The purge gas inlet is to the left rear upper, the circulating fluid connectors to the right rear lower, and the electrical and additional temperature probe connectors are above the circulating fluid connectors.

On the right within the ESHU is a lid open sensor; when the lid is raised, no experiment can be started and any that are in progress will be paused.
The ESHU attaches to the monochromator section of the spectrometer with four thumbscrews (Figure 3.7). To remove the ESHU, disconnect the nitrogen purge gas connection (Section 3.3), release the thumbscrews and slide the ESHU to the right, away from the monochromator. Do not alter the height settings on the ESHU feet.

To replace the ESHU, perform the removal operation in reverse. The ESHU and monochromator should align precisely; if they do not, make the necessary height adjustment using the three adjustable feet beneath the ESHU, not those on the monochromator.

3.6 Detectors

3.6.1 CD detector options

The Chirascan uses a photomultiplier tube (PMT) for CD detection. The Standard PMT has an operating range from 165 nm to about 900 nm. The longer wavelength limit in the near IR can be extended with the IR3 Extended NIR PMT accessory, which is suitable for use over the range <250 to 1250 nm.

The Chirascan-plus uses a large area avalanche photodiode (LAAPD) detector with an operating range from 165 nm to about 1360 nm.

3.6.2 Removal and replacement

WARNING The photomultiplier tube (PMT) detector used with the Chirascan and the large area avalanche photodiode (LAAPD) detector supplied with the Chirascan-plus operate at high voltages and can produce a shock leading to serious injury or death. Do not connect or disconnect the detector from the spectrometer unless the spectrometer is powered off.

To remove a detector, ensure that the spectrometer is powered off and disconnect the cable. Loosen the knurled locking ring by rotating anticlockwise (counterclockwise) and gently withdraw the detector. To protect the detector, fit the window cover when the detector is not installed on the spectrometer (Figure 3.8).
To replace CD the detector, perform the above operation in reverse ensuring either that the spectrometer is powered off, or that the detector high voltage is set to zero, before reconnecting. The shoulder of the detector should seat down onto the nitrogen purge ring (Figure 3.9).

Figure 3.9: the CD detector in position in the ESHU

For instructions on the installation of the fluorescence detector, see the Fluorescence Accessories User Manual.
3.7 Maintenance

If used with care, the Chirascan series spectrometer should provide many years of reliable service.

**NOTICE**  Do not allow aggressive or corrosive chemicals to come into contact with the spectrometer: clean up any spillages immediately. To clean the spectrometer, use a soft cloth with a dilute solution of mild detergent in water.

APL suggest that the instrument is serviced regularly, and preferably that the user takes out a service contract. Please contact APL Technical Support Section for further advice.

3.8 Moving the spectrometer

3.8.1 Parking the monochromator

**NOTICE**  The monochromator has components than can be damaged if their movement is not restricted when the spectrometer is moved. This movement is restricted by parking the monochromator.

To park the monochromator, open the Monochromator dialog box (Section 4.13.2), and click the Park mono button (Figure 3.10).

![Figure 3.10: the Monochromator dialog box](image)

3.8.2 Lifting and moving the spectrometer

**CAUTION**  The spectrometer weighs about 80 kg (180 pounds), and should only be moved manually if enough people are available to support this weight.

**NOTICE**  The spectrometer has designated lift points, and lifting at the wrong points can result in damage to the instrument. Do not attempt to lift or move the spectrometer except under guidance from APL’s technical support section.
4 PRO-DATA CHIRASCAN

4.1 The Spectrometer Control Panel

The purpose of Pro-Data Chirascan is to control the spectrometer and its accessories and to acquire data. It has been written to be versatile enough to cope with a wide variety of experiments while being simple to use. It operates under Windows 7 and some earlier versions of Windows. The object-oriented modular architecture is easily expandable, allowing the introduction of new features, anticipating future developments.

The software is launched by clicking on the desktop icon . The Spectrometer Control Panel of Pro-Data Chirascan (Figure 4.1) will appear on the screen.

![Figure 4.1: the Spectrometer Control Panel](image)

The SCP enables you to provide instructions to the spectrometer so that it carries out an experiment or a series of experiments according to your requirements. The interface is supplemented by drop-down menus for the management of files or the launching of associated programs. Shortcuts to the most commonly used items from the drop-down menus are provided by the toolbar icons.
4.2 The Signal panel

4.2.1 General

The Signal panel (Figure 4.2) is used to select the mode of data collection. Unless other accessories are fitted, four options can be selected from the drop-down menu: Circular Dichroism, Absorbance Fluorescence, and Voltage. The panel changes appearance to reflect the mode of data collection. The panel for fluorescence is described in the Fluorescence Accessories User Manual, those for the other three options are described below.

Common to all four is an oscilloscope-style live signal display that can be launched by clicking on the icon in the top right corner of the panel (Figure 4.3). The units will be those of the chosen measurement mode; an instantaneous value of the measurement is also displayed in the box to the right of the drop down menu.
4.2.2 The Signal panel for Circular dichroism

The most commonly used mode of data collection is circular dichroism. When this option is selected, the Signal panel has two sub-panels, **Options** and **Background** (Figure 4.4). On the **Options** subpanel, choose either **delta A** (delta absorbance) or **milidegrees** for the units of the CD measurement.

The **AutoPM** button will adjust the detector HV so that the photomultiplier anode current resulting from the intensity seen by the detector is at the optimum level for the Chirascan electronics.

Tick the **Absorbance** check box if you wish to simultaneously record an absorbance spectrum of the sample (recommended), but note that a background must be acquired before the absorbance can be obtained. To acquire a background spectrum, click the **Background** button on the **Signal** panel (Figure 4.4). The background spectrum must have a point corresponding to each point in the measured spectrum (it may have additional points). It is not necessary to take a background spectrum if only the CD measurement is required.

**Notice**

On the Chirascan, in CD mode the absorbance is derived from the detector HV and although it gives a good indication of the correct value, it may differ slightly from an accurately determined value obtained when the measurement is made in direct absorbance mode on Chirascan, or on a dedicated UV-visible absorbance spectrometer. On the Chirascan-plus, in CD mode the absorbance is derived from the detector gain, which is know precisely, and the absorbance is therefore identical to that measured in direct absorbance mode on the Chirascan-plus or on a dedicated UV-visible spectrometer.

Unless the spectrometer is equipped with a fluorescence accessory, the **Fluorescence** check box will be inactive. See the fluorescence accessories manual for further information on fluorescence measurement.

The **Background** subpanel is used to measure a CD background. Clicking on **Background** will initiate a CD measurement using the experimental parameters defined elsewhere in the interface. Pro-Data viewer will be launched automatically and the display will show the CD background trace. The measurement can be stopped at any time by clicking **Stop**, which is the label that appears on the **Background** button during a measurement; it can also be **Paused** and **Resumed**, using the buttons in the **Sequencer** panel (Section 4.7). At the end of the measurement, the background will be stored as Backgroundxxxx.dsx, unless a different seed name has been
specified (View>Preferences>Seed names, toolbar ). If the filename already exists, a Save As panel will open in the current working directory and the data can be saved with a different name or in a different location. The Auto Subtraction check box becomes active at the conclusion of a background scan; tick the box if you wish to subtract the background automatically from subsequently measured CD spectra.

Show... is used to reinstate a previously-measured CD background. It calls up the Quickview - CD Background dialog box that enables you to load any background file (Figure 4.5).

![Figure 4.5: the Quickview – CD background dialog box](image)

Click on Recall Last to reinstate the most recently measured background; click on Load... to browse for other background files. The chosen file will appear in the preview window. The Smooth button will smooth the trace, which is useful if you wish to subtract a single background from a number of spectra that are to be averaged. Under these circumstances, smoothing prevents reinforcement of the background noise in the final result.

Save... and Print... have their usual functions. Click on OK to confirm your choice and close the dialog box or Cancel to close without implementing the new background.

Calibration is used to recalibrate the CD scaling factor and requires administrator privileges to gain access to it. It should not be necessary to use it routinely and will be greyed out for the normal user. Please refer to Section 4.15.1 if you wish to recalibrate the CD.
4.2.3 The Signal panel for Absorbance

Figure 4.6: the Signal panel with Absorbance selected

When Absorbance is selected on the Signal panel (Figure 4.6), the absorbance will be measured directly, rather than derived from the HV signal if the Absorbance check box is ticked with circular dichroism selected. The directly measured absorbance gives accurate values, comparable to those obtained on a dedicated absorbance spectrometer, but when this option selected the CD signal cannot be measured simultaneously.

The Options subpanel enables you to choose between Absorbance and Transmission as the measured variable. If the fluorescence accessory is present, you will optionally be able to record a simultaneous fluorescence excitation spectrum by ticking the Fluorescence check box. For more information on making fluorescence measurements, see the Fluorescence Accessories User Manual.

The Background subpanel is used to measure a reference background relative to which the absorbance of the sample is calculated. Selecting Auto HV in Background will optimise the high voltage applied to the detector for every point in the background scan. These values are remembered and applied at each corresponding point in the subsequent absorbance scan, allowing an accurate absorbance spectrum to be recorded easily. Clicking on Background will initiate a background measurement using the experimental parameters defined elsewhere in the interface. The measurement can be stopped at any time by clicking Stop, which is the label that appears on the Background button during a measurement. At the end of the measurement, the background will be stored as Backgroundxxxx.dsx, unless a different seed name has been specified.

With the background measured, insert the sample and click on Acquire in the Sequencer panel to measure an absorbance spectrum.
4.2.4 The Signal panel for Voltage

Note that this panel is intended for diagnostic purposes only. It is unlikely that you will need to use it in the normal course of events.

The five signal channels currently assigned are auxiliary1, auxiliary2, fluorescence, circular dichroism DC and circular dichroism AC. Only those that are actually installed will be highlighted in the **Voltage** panel (Figure 4.7); the others will be greyed out.

When in voltage mode, channels 1 to 4 operate in a similar fashion: each provides a voltage scan proportional to the intensity of a signal falling on the detector photocathode at a fixed detector high-voltage. This allows sensitivity checks and elementary voltage scans to be performed for diagnostic purposes. For example, you could use the fluorescence channel to determine where the maximum intensity of a fluorescing sample occurs or the CD DC channel in the absence of a sample to look at the lamp profile.

Channel 5, the CD AC channel, gives access to the voltage arising from the polarization modulation induced by the photo-elastic modulator. It is non-zero only in the presence of a sample with a chiral chromophore (or if a birefringent medium is placed in the path of the modulated CPL). The information measured with this channel is subsequently used in conjunction with the information from the CD DC channel to derive the circular dichroism of the sample.

4.3 The Shutter / attenuator panel
This part of the SCP controls the shutter/attenuator mechanism. The shutter/attenuator can be opened or closed by clicking on the **Open** and **Close** buttons. The graphic to the right of these buttons represents the shutter/attenuator status: black is closed and yellow is open.

Click on **Zero HV** to set the HV on the detector to zero. With zero voltage on the detector, the button will read **Restore HV** – click on it to restore the high voltage to its previous value. Use this before disconnecting or reconfiguring detectors.

**AutoShutter** automatically opens and closes the shutter during instrument operation. If the **AutoShutter** check box is not ticked, then the Chirascan will not open the shutter at the start of a scan, or close it at the end of a scan. However, if the shutter is closed at the start of a scan, the user will be presented with a warning message.

**AutoShutter** is selected by default. This provides automatic opening of the shutter at the start of a scan and closes it at the end. It also closes the shutter while waiting for the temperature to stabilize during temperature-ramp experiments or during titration experiments when waiting for titrant to be added. The main purpose of **AutoShutter** is to minimise the exposure time of a sample to intense radiation.

### 4.4 The Monochromator panel

#### 4.4.1 General

![Figure 4.9: the Monochromator panel](image)

The **Monochromator** panel (Figure 4.9) provides access to the parameters that control the operation of the Chirascan monochromator. Here you set the scan range, step-size and bandwidth for your experiment; you can also move the monochromator to a specific wavelength.

To drive the monochromator to a specific wavelength, use the **Wavelength (nm)** edit box and click the **Set** button below the box; to set the bandwidth, use the **Bandwidth (nm)** edit box and click the same **Set** button. Setting wavelength and bandwidth can be done simultaneously with a single click.

To set the wavelength range for a scan, use the **Low** and **High** edit boxes to set the lower and upper wavelength limits; use the **Step** edit box to set the step-size; all units are nanometres. Click on the **Set** button to the right of these boxes to confirm these parameters. Note the Chirascan always scans from high to low wavelength.

To save the current monochromator parameters as the default ones, click on the **Adv...** button, which displays the **Monochromator Scan Setup - Advanced** dialog box (Figure 4.10) and click on **Save As Default**. Click **OK** to take you back to the Pro-Data interface.
4.4.2 Advanced mono setup: discrete wavelengths

The Monochromator Scan Setup - Advanced dialog box (Figure 3.10) can be used to set the software up to perform single wavelength scans. Such measurements are useful when following a change in property as a function of some independent variable other than wavelength - temperature, for example.

Select Single wavelength and specify the wavelength in the associated edit box. Click OK. The dialog box will close and when you click on the Start button in the Spectrum panel of the interface, the monochromator will drive to the selected wavelength and measure the CD or other chosen property of the sample at that wavelength.

It is also possible to create a list of discrete wavelengths. Clear the wavelength list by clicking on Clear list and then select Append to list. Now select Single wavelength, specify the wavelength in the edit box and click on Generate list. Each time you type in a wavelength and click on Generate list, the specified single wavelength will be appended to the list. When you are satisfied that the list of wavelengths is correct, click OK. When you click on Start in the Spectrum panel of the interface, the monochromator will drive to the selected wavelengths in the order they appear in the list and measure the CD or other chosen property of the sample at those discrete wavelengths.

4.4.3 Advanced mono setup: skip-scans

A simple wavelength range can be set in the Monochromator panel and there is no need to use the advanced panel to set such a range (see Section 4.4). However, if you wish to carry out a more sophisticated scan, select Wavelength range in the Monochromator Scan Setup - Advanced dialog box. Then clear the wavelength list by clicking on Clear list and then select Append to list. Now select Single wavelength, specify the wavelength in the edit box and click on Generate list. A number of entries that correspond to your specification will appear in the list. Then enter the Start, Stop and Step values for the second range and click on Generate list once more. The new values will be appended to the existing values in the list. Repeat this cycle until you have completed the skip-scan list. The total number of entries in the list is recorded at the foot of the list.
Skip-scans are in general used on samples that you know well and that you might wish to measure again in the future. Use the Save As... button to save the list as a .conf (configuration) file that can be retrieved using the Load button at a future date. This obviates the need to generate a new list every time you run the sample.

With the list generated, click on OK to return to the SCP. When you click on Acquire in the Sequencer panel, the monochromator will drive to the wavelengths specified in the list in the order in which they appear in the list and the instrument will measure the chosen property (CD, voltage, fluorescence, etc.)

4.5 The Trigger and Timebase Panels

The Trigger and Timebase panels (Figure 4.11) are visible when operating in Kinetics or Spectra-Kinetics modes. The Trigger drop down menu will only allow the selection of Internal unless the CS/SF stopped-flow accessory is fitted.

The acquisition Time and number of data Points are set using the drop down menus in the Timebase section. The Samples box displays the number of samples which will be averaged in order to obtain each data point. Selecting the Logarithmic option results in the logarithmic distribution of data points over the selected acquisition time. This feature may be useful when the kinetic change being monitored has a fast initial phase, but a slower second phase. As an alternative a Split Timebase may be used in which data points are distributed between two linear intervals.

4.6 The Sampling panel

The Sampling panel (Figure 4.12) is visible when operating in Spectrum mode, and is used to control the sampling time for each point in a scan. Use the Time-per-point (s) edit box to specify the time in seconds to be spent collecting data at each point; an approximate scan-time is calculated from the product of the time-per-point and the number of points in the scan (specified in the Monochromator panel, Section 4.4).

If the Enable Adaptive Sampling check box is ticked, the time-per-point is varied inversely as a function of the light reaching the detector. Where the signal is weaker, more time is spent collecting data than where it is...
stronger. The algorithm has been developed such that it will usually take less time to measure a spectrum than at constant time-per-point.

Clicking on the Adv... button calls up the Sampling – Advanced dialog box (Figure 4.13).

![Sampling - Advanced dialog box](image)

Figure 4.13: the Sampling – Advanced dialog box

The Sample period (µs) can be set at any value between 10.0 µs and 1000.0 µs in the edit box, followed by clicking on the Apply button.

The Default number of samples can be set anywhere between the minimum and maximum limits (see Sampling limits below). The product of the sample period and the number of samples yields the current time-per-point. The default number of samples is superseded by changing the Time-per-point in the Sampling panel, as described above.

Selecting Disable oversampling will do precisely what it says and is used for diagnostic purposes only. If it is selected, a warning is given (Figure 4.14); for all non-diagnostic use, oversampling must be used.

![Disable oversampling warning message](image)

Figure 4.14: the Disable oversampling warning message
Sampling limits can be changed but the default values are best suited to routine operation. The minimum time-per-point will be 25 μs multiplied by 10 samples, i.e. 250 μs; the maximum time-per-point will be 25 μs multiplied by 4000000 samples, i.e. 100 seconds. These limits apply to all experiments, whether set up using constant time-per-point or using adaptive sampling; they are particularly useful in placing limits on the extremes of adaptive sampling.

4.7 The Sequencer panel

The Sequencer panel (Figure 4.15) allows you to specify the type of measurement you will make and to control the starting, stopping, pausing and resuming of data acquisitions. Tick the Repeats check box to run repeats of the same experiment, and enter the number of repeats in the adjacent edit box. The between individual measurements in Timed intervals, which is the time between the beginnings of successive repeats; if it is set to be shorter than the time for each run, then each run will begin after the previous one. All data from repeat runs will be written to a single Datastore.

The radio buttons allow you to select the type of measurement you will carry out. It will usually be Spectrum for Chirascan. Click Acquire to begin an acquisition according to the instructions in the SCP; clicking Stop (which appears after Acquire has been clicked) will abort the acquisition; clicking Pause will stop the acquisition without aborting and Resume (which appears after Pause has been clicked) will restart the acquisition from the point at which it was paused.

4.8 The Progress and Status panel

The Progress and Status panel (Figure 4.16) provides information concerning the current status of the spectrometer and of data acquisition. The box on the left of the panel will give the status (e.g. Ready, Stirring, Acquiring); the two bars to the right of the panel give a visual representation of the progress.
4.9 The Temperature Control Unit panel

The Temperature Control Unit panel (Figure 4.17) is disabled unless a temperature control device, such as the CS/PCS single cell controller or CS/PCM 4-cell autochanger, is fitted. For further information see the User Manual for the fitted device.

4.10 The Sample Handling Unit panel (ESHU) panel

The Sample Handling Unit (ESHU) panel (Figure 4.18) shows the temperature of one of up to four temperature probes (T1 to T4, selected from the drop-down menu); in the above figure, probe T1 is registering 23.5°C. The temperature measured by the chosen probe is one of the properties recorded in the Datastore.

Click the Setup… button to reveal the Multi-cell Sample Setup dialog box (Figure 4.19).
Do not tick the **Enable Multi-cell AutoChanger** box unless the PCM.3 is fitted. Use the edit boxes to enter a description of your sample and cell. The information is stored in the Datastore and can be viewed in Pro-Data Viewer (Section 5.1.3).

The **Titration** button is inactive unless the CS/TT titration accessory id fitted, and the **Stirrer** button is inactive unless the CS/PCS or CS/PCM are fitted. For more information see the User Manuals for those devices.
4.11 Toolbar icons

![Toolbar Icons](image)

**Figure 4.20: the SCP Toolbar**

The SCP toolbar is shown in Figure 4.20. Positioning the cursor over an icon will call up a brief description; a fuller description is also provided in the status bar at the foot of the SCP. The action of clicking on each icon is described below:

- ![Open Document](image)
  - Opens a new document.

- ![Open File](image)
  - Opens a previously collected data file. This will open a window showing the contents of the currently active directory or the examples folder if you have just launched Pro-Data. Opening a data file from this window will configure the interface with the experimental parameters contained in that file.

- ![Save Document](image)
  - Saves the active document. If there is new data that needs saving, this icon will open a **Save As** window showing the currently active directory. If there is no new data, an information window saying so will appear.

- ![File Names](image)
  - Opens the **File Names** dialog box, in which you can specify seed names for spectra and backgrounds. In a series of experiments, the file names will share the chosen seed name and be differentiated by an automatically incrementing numeric component, e.g. Protein0001, Protein0002…

- ![Remarks and Comments](image)
  - Opens the **Remarks and Comments** window, in which you can record information about your experiments. The remarks are stored in the Datastore and can be viewed in Pro-Data viewer.

- ![Preferences](image)
  - Opens the **Preferences** dialog box, in which personal preferences can be set. A full description is given in Section 4.14.

- ![Launch Viewer](image)
  - Launches Pro-Data Viewer (Chapter 5).

- ![About Chirascan](image)
  - Calls up **About** Chirascan window, which gives the Chirascan software version.

- ![Context Sensitive Help](image)
  - Click this icon and then on item of interest to call up the context sensitive help for that item.
4.12 Drop-down menus

Much of what is available in the drop-down menus is more readily accessible from the icons in the toolbar. A full list of the functionality is given below; inevitably, there is some repetition of the information in Section 4.11.

4.12.1 The File menu

![Figure 4.21: the File menu](image)

The File menu (Figure 4.21) presents the usual options and shortcuts for opening and closing files. It is unlikely that you will need to use these, because their functionality is more conveniently accessible elsewhere in Pro-Data and in Pro-Data viewer. The examples folder can be accessed from this menu, in which there are several examples of spectra supplied by APL that can be used as templates to set up Pro-Data or as tools to familiarise oneself with the use of Pro-Data viewer.

4.12.2 The View menu

![Figure 4.22: the View menu](image)

The View menu (Figure 4.22) offers five options.

- **ProData Viewer** launches ProData Viewer (Chapter 5).
- **Devices…** opens the Devices Window. This contains a number of icons corresponding to hardware devices that may need to have certain parameters adjusted. See Section 4.13 for more details.
- **Remarks…** opens the Remarks and Comments window, in which you can record information about your experiments. The remarks are stored in the Datastore and can be viewed in Pro-Data viewer.
- **Toolbar** a toggle to show or hide the toolbar.
- **Always on top** a toggle to ensure that Pro-Data Chirascan is always visible.
4.12.3 The Configuration menu

![Configuration Menu](image)

Figure 4.23: the Configuration menu

The Configuration menu (Figure 4.23) offers three options:

- **Change Sample Handling Unit (SHU)** opens the Select SHU dialog box (Figure 4.24). Unless the Kinetics Sample Handling Unit (CS/SF) is fitted, **Equilibrium Sample Handling Unit** should be selected.

![Select SHU Dialog Box](image)

Figure 4.24: the Select SHU dialog box

- **Access Control** opens a panel showing the names of members of security groups with access to the ProData software
- **Preferences** opens the Preferences dialog box in which personal preferences can be set. A full description is given in Section 5.7.4.

4.12.4 The Help menu

![Help Menu](image)

Figure 4.25: the Help menu

The Help menu (Figure 4.25) presents two items:
• **Help Topics** launches the help manual. You can browse the contents and search for specific words and phrases.

• **About Chirascan** opens a window giving the version number of the Chirascan software.

### 4.13 The Device window

#### 4.13.1 General

Select **Devices** from the **View** drop-down menu to reveal the **Device Window** (Figure 4.26). Many of the icons require a service password or are inactive, and their action is not described here. Others are only active when a particular accessory is installed, and the user is referred to the relevant User Manual. The action of the remaining icons is described below.

**System Reset** will reset any user-adjustable parameters accessible through the **Devices** panel to their factory defaults. It is unlikely that you would need to do this.

**Calibrate Zero Offsets** will adjust the electronic offset to take into account any small drift that may have occurred over time. It is unlikely that you will need to do this on a regular basis. The offsets should not be changed until the instrument electronics are at their normal working temperature (it is good practice to leave the electronics powered on at all times) nor should they be changed part-way through a series of experiments, since recalibrating the offsets may shift the CD background slightly.

**Service Password** opens a dialog box that permits you to change the password that gives access to the advanced sections of the Device window. If you change it, do not forget it because APL engineers will not be able to rediscover it for you.

![Figure 4.26: the Device window](image)
4.13.2 Mono1

the Mono1 icon displays the Monochromator window (Figure 4.27).

![Monochromator window](image)

**Figure 4.27: the Monochromator window**

In the **Wavelength** panel, the slider bar or the edit box can be used to specify a wavelength; clicking the **Set** button will drive the monochromator to the chosen wavelength.

Likewise, the **Bandwidth** panel can be used to set the bandwidth. These settings are the ones to which the monochromator will drive when the software is started.

The **Status** panel reports what the monochromator is doing – when it is executing your instruction, the status reported would be **Updating** and **No** respectively in the **Current action** and **Reached target** boxes and on completion the text would read **Ready** and **Yes**, as shown above. The temperature of the mono block is recorded and can be refreshed using the button adjacent to the reported temperature. **Reset** causes the mono to verify its limits, both in wavelength and bandwidth.

**Park mono** puts it into a safe position, ready for transportation. When you are happy that the parameters are correctly set, click **OK**; to close the panel without implementing the changes, click **Cancel**.

The **Calibration File** panel should be used only under instruction from APL technical support.
4.13.3 The attenuator

The Attenuator icon displays the Attenuator / Shutter Control window (Figure 4.28).

![Attenuator / Shutter Control window](image)

**Figure 4.28: the Attenuator / Shutter Control window**

The attenuator operates both as attenuator and shutter. The Open and Close buttons have the same action as those found in the Pro-Data interface (Section 4.3) and are linked to them; changes in one set are replicated in the other.

The maximum opening can be limited using the slider bar and this may be appropriate in special circumstances (for example to reduce damage to samples) but in general the attenuator should not be limited in its maximum aperture. The status of the aperture is shown on the Current attenuator position slider; if the maximum aperture were limited, then that would also be shown in the slider position. The shutter display on the SCP is linked to this function and therefore the status of the attenuator can be ascertained from there too.
4.13.4 The circular dichroism DC channel

The CDDC icon displays the **CD DC Photometric Channel** dialog box (Figure 4.29).

Figure 4.29: the CD DC photometric Channel window

The Chirascan and Chirascan-plus are CD spectrometers and therefore this channel (and the CD AC channel) will always be active.

**Chirascan**
On the Chirascan, The **CD DC Photometric Channel dialog** permits you to apply voltages to the CD detector, which governs its gain. The **PMT HV** slider allows you to choose an arbitrary detector HV between 0 and 1000 volts; the **ZeroHV** button will set the voltage to zero; the **AutoPM** button will adjust the detector HV so that the photomultiplier anode current resulting from the intensity seen by the detector is at the optimum level for the Chirascan electronics. Click on the **Apply** button to apply the HV to the detector. In a CD scan, the detector HV (and so its gain) is adjusted so that at every point in the spectrum, the anode current is at its optimum level for the Chirascan electronics. If this window were open during a CD scan, the **PMT HV** slider and the associated edit box would show HVs that changed as the scan progressed, being high where the sample absorbance is high and low where the absorbance is low.

**Chirascan-plus**
On the Chirascan-plus, the way the solid state LAAPD CD detector works is quite different from the photomultiplier tube (PMT) detector used on the standard Chirascan. A PMT has a variable voltage applied to the anodes, which varies the gain of the detector, optimizing the recorded CDDC and CDAC signals. The LAAPD is operated with a constant detector gain, but the detector electronics has a cascade of programmable amplifiers that boosts the gain to optimize the signal (See Chapter 6 for more details). The variable gain of the LAAPD detector is made to simulate the change in gain with anode voltage of a PMT. Consequently the user control of the Chirascan-plus is the same as that of a standard Chirascan, as well as being familiar to users of other CD instruments. The CD DC Photometric Channel dialog permits you to apply a specific gain to the CD detector. The **PMT HV** slider allows you to choose an arbitrary detector gain, with the higher the HV, the higher the gain applied. The **AutoPM** button will adjust the detector emulated HV so that the LAAPD amplifier gain produces an
output signal that is at the optimum level for the Chirascan-plus electronics. Click the **Apply** button to apply the HV to the detector. The **ZeroHV** button will turn the gain to zero, as well as turning off the LAAPD bias voltage, allowing safe removal of the detector. In a CD scan, the detector gain (and so its emulated HV) is adjusted so that at every point in the spectrum, the anode current is at its optimum level for the Chirascan electronics. If this window were open during a CD scan, the **PMT HV** slider and the associated edit box would show emulated HVs that changed as the scan progressed, being high where the sample absorbance is high and low where the absorbance is low.

Clicking the **Advanced…** button will cause a password prompt to appear, and users should not proceed except under instruction from an APL engineer.

### 4.13.5 Device icons requiring accessories

The device icons below require accessories:

- Requires a CS/TF fluorescence detector: see the Fluorescence Accessories User Manual
- Requires the CS/SEM scanning emission monochromator: see the Fluorescence Accessories User Manual
- Requires the CS/TT dual syringe titration unit: see the CS/TT User Manual
- Requires an CS/SF stopped flow accessory: see the CS/SF User Manual
- Requires the CS/PCS single-cell Peltier temperature controller: see the CS/PCM User Manual
- Requires the CS/PCM 4-cell autochanger: see the CS/PCM User Manual
4.14 The Preferences dialog box

Clicking on the Preferences icon or selecting Preferences... from the Configuration drop-down menu will display the Preferences dialog box.

4.14.1 The Viewer tab

![Figure 4.30: the Viewer tab]

The dialog box opens at the Viewer tab (Figure 4.30) where the appearance of Pro-Data Viewer when launched can be controlled (with or without the blank display), and whether or not the display automatically rescales when a data point is measured that is outside the limits of the currently-displayed y-axis.

4.14.2 The CD tab

![Figure 4.31: the CD tab]

On the CD tab (Figure 4.31), preferences for CD measurements can be set. In the Default Mode panel, select either delta A (delta absorbance) or millidegrees as the units for expressing circular dichroism; in the Auxiliary Measurements panel, HT is greyed out and permanently selected, i.e. the detector HV (Chirascan) or emulated HV (Chirascan-plus) will always be recorded in CD mode, and in the AutoAbsorbance panel Enable AutoAbsorbance by default can be selected, which is recommended.
4.14.3 The Absorbance tab

![Absorbance Tab Image](image)

Figure 4.32: the Absorbance tab

On the **Absorbance** tab (Figure 4.32), preferences for absorbance measurements can be set. In the **Default Options** panel, select to measure spectra either at constant detector high-voltage (HV) (**AutoPM** not selected) or at an HV (Chirascan) or emulated HV (Chirascan-plus) that is automatically optimized at each point in the spectrum (**AutoPM** selected). Constant HV or emulated HV will normally give the more accurate absorbance measurement because there is no risk of hysteresis associated with sharp changes in the detector HV or HV but you must be careful to ensure that the detector is not saturated during the measurement. Selecting **AutoPM** will remove that possibility and because there are unlikely to be big changes in HV or emulated HV from one point to the next, using **AutoPM** will not degrade the absorbance measurement in any significant way. It is recommended that this option is selected.

4.14.4 The Fluorescence tab

![Fluorescence Tab Image](image)

Figure 4.33: the Fluorescence tab

There are no active panels on the Fluorescence tab (Figure 4.33).
4.14.5 The Data Acquisition tab

The conditions on the Data Acquisition tab (Figure 4.34), have been established as optimal by Applied Photophysics’ engineers, and they should not be changed except under guidance from ALP Technical Support.

![Figure 4.34: the Data Acquisition tab](image)

4.14.6 The File Names tab

On File Names tab (Figure 4.35), seed names for spectra and backgrounds can be set. In a series of experiments, the file names will share the chosen seed name and be differentiated by an automatically incrementing numeric component, e.g. Protein0001, Protein0002… This panel can be accessed directly using the File names icon on the toolbar (Section 4.11).

![Figure 4.35: the File Names tab](image)
4.14.7 The Startup Preferences tab

![Startup Preferences tab](image)

Figure 4.36: the Startup Preferences tab

On the **Startup Preferences** tab the SCP can be set to open in **Spectrum**, **Kinetics** or **Spectra-Kinetics** modes. For Chirascan, the default **Spectrum** is usual. You can also choose to start the software in emulator mode, i.e. in the absence of any hardware, but that is unlikely to be of interest during normal use.

4.15 Recalibrating the Chirascan

4.15.1 Recalibrating the CD

Note that you will need system administrator privileges to change the CD calibration factor.

(1S)-(+)-10-camphorsulphonic acid (1S-CSA) is widely used for the calibration of CD instruments. Some care needs to be taken in its preparation for it to be used for calibration purposes, because it is hygroscopic and therefore difficult to weigh accurately. However, CSA has been studied in depth and is known to have an ellipticity of 335 millidegrees when a solution of precisely 1 mg/ml is measured in a 10 mm pathlength cuvette. It is also known that the extinction coefficient of anhydrous CSA is 34.5 at its absorbance maximum (285 nm), and the concentration of a solution made up to approximately 1 mg/ml can therefore be determined accurately from its absorbance characteristics. A solution containing exactly 1 mg/ml will have an absorbance of 0.1486 AU in a 10 mm pathlength cuvette. Using proportionality, one can then calculate the CD value for a CSA solution once its absorbance at 285 nm as been accurately determined. 1S-CSA is available from the Sigma-Aldrich Company, product code C-1395.

<table>
<thead>
<tr>
<th>Name</th>
<th>(1S)-(+)-10-camphorsulphonic acid</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Sigma C-1395</td>
</tr>
<tr>
<td>Molecular weight</td>
<td>232.3</td>
</tr>
<tr>
<td>Target concentration</td>
<td>1 mg/ml</td>
</tr>
<tr>
<td>Solvent</td>
<td>Distilled water</td>
</tr>
</tbody>
</table>

Table 4.1: conditions for CD calibration
The conditions for the calibration are summarized in Table 4.1. Firstly, make up a solution of CSA at about 1 mg/ml in distilled water. Determine its concentration accurately by measuring its absorbance maximum at 285 nm in a 10 mm pathlength cell. It is important to use the Absorbance program (Section 4.2.3) to calculate the absorbance of the CSA (see also Chapter 6 of this User Manual).

The concentration is calculated from:

\[
\text{Concentration of CSA (mg/ml)} = \frac{\text{Observed absorbance}}{0.1486}
\]

and the expected CD value for this concentration in a 10 mm pathlength cell at 290.5 nm thus:

\[
\text{CD value at 290.5 nm} = 335 \times \left(\frac{\text{Observed absorbance}}{0.1486}\right)
\]

Set the wavelength to 290.5 nm, the bandwidth to 1 nm and the time-per-point to 1 second. If you have administrator privileges, the Calibration... button in the CD signal Background panel will be active. Click on it to open the CD calibration dialog box (Figure 4.37) and make a note of the current Desired CD value (mdeg) and Calibration value (then, if necessary, these values can be reinstated and activated by clicking Apply and then OK).

![Figure 4.37: the CD calibration dialog box](image)

Type the CD value you have just calculated for your CSA solution into the Desired CD value (mdeg) box and click Measure. The calibration procedure will take a measurement of the CD at 290.5 nm and adjust the Calibration value automatically. If you are happy with the outcome, click Apply and then OK.

Check that the calibration is correct by measuring the CD spectrum of your CSA solution over the range 320 nm to 260 nm, using 0.5 nm steps, and use the cursor in Pro-Data Viewer to establish that the observed and calculated values at 290.5 nm are the same.

4.15.2 Recalibrating the derived absorbance (Chirascan only)

There is no derived absorbance on the Chirascan-plus: the absorbance measured in CD mode is derived directly from the detector gain, and is identical to that measured in direct absorbance mode, or on a dedicated UV-visible spectrometer.

On the Chirascan, the derived absorbance calculated during a CD measurement is an approximation, which will be reasonably accurate if the calibration value is correct. In the file autoabs.conf stored in C:\Program files\Applied Photophysics\Chirascan\Config you will find a single number. This is the scaling factor that relates the true absorbance to the derived absorbance. To adjust this scaling factor, you must measure the true
absorbance of a sample and then its derived absorbance in CD mode. Accurate knowledge of the concentration of the sample is not required.

Calculate the correction factor from:

\[
\text{Factor} = \frac{\text{True absorbance}}{\text{Derived absorbance}}
\]

and multiply the scaling factor in the autoabs.conf file by the correction factor.

A didymium absorbance calibration standard with an absorbance of about 0.5 AU is used for the initial calibration by APL production department, and gives good results, but any absorbing sample will do. For example, a 3 mg/ml solution of 1S-CSA in a 10 mm pathlength cell should give an absorbance of approximately 0.45 AU relative to water at its absorbance maximum of 285 nm. (It is not essential to use CSA and you may choose to use another compound – all that is important is that the sample has a significant absorbance at a convenient wavelength.)

For 1S-CSA, set the monochromator range to 270 nm to 300 nm, the step size to 0.5 nm and the bandwidth to 1 nm. Set the time-per-point to 1 second (for other compounds a different wavelength range would be used).

Place a cell containing distilled water in the sample compartment. Select Circular Dichroism from the dropdown menu in the Signal panel and click Background. Before removing the blank, select Absorbance from the drop down menu in the Signal panel and click Background again. Now replace the water with the sample. Without changing anything, click Acquire to measure the true absorbance spectrum. Now select Circular Dichroism again. Click Show… in the Background panel and Load to reinstate the CD background measured previously. With the CD background loaded, click Acquire to measure the CD spectrum and derived absorbance of the sample.

To see the derived absorbance spectrum, right-click on the y-axis legend and select Absorbance. Use the cursor to determine the absorbance maximum of both the derived and the true absorbance and from these, determine and apply the correction factor as described above. Remember that the derived absorbance is only an approximation. Its function is to provide you with a reasonably accurate indication of whether or not you are within acceptable absorbance limits when measuring a CD spectrum.

The scaling factor will vary slightly with wavelength: ensure the scaling factor is calculated using a wavelength as close as possible to where most of your measurements will be carried out. The factor will change slightly as the detector ages. Occasional checking is advisable. The frequency will depend upon usage of the instrument, but once every six months or so would be appropriate for most laboratories.
5 PRO-DATA VIEWER

This Chapter describes the Pro-Data Viewer program, which is designed to display and manipulate data and to store them securely.

5.1 Introduction

Pro-Data Viewer can be used either online, with a client-server link between the spectrometer control panel (SCP) and Pro-Data Viewer, or off-line as a standalone program.

Pro-Data Viewer opens with two windows, the launchpad, which shows a list of the files in the current folder, and the graphics display, where data will be plotted (Figure 5.1).

The status of Pro-Data Viewer is shown on the status bar at the foot of the launchpad window, where the words Ready (Online) or Ready (Offline) will be found.

![Figure 5.1: Pro-Data Viewer, showing the launchpad, left, and graphical display, right](image-url)
5.1.1 Launching Pro-Data Viewer

Pro-Data Viewer can be launched as a stand-alone program using the desktop icon and will open at the current working directory. Pro-Data Viewer will be offline when launched in this way, i.e. there will be no link with the spectrometer control panel (SCP).

Pro-Data Viewer can also be launched from the Pro-Data Chirascan spectrometer control panel (SCP) by clicking on the Pro-Data Viewer launch icon in the SCP toolbar, when a client-server link between the SCP and Pro-Data Viewer will be established automatically. When launched in this way, Pro-Data Viewer will be online, and becomes a live display for data as they are collected, although it can still be used for display and manipulation purposes.

If Pro-Data Viewer is started independently of the SCP using the desktop icon and you subsequently wish to establish a link between the programs, this can be done in the Preferences window (Section 5.7.4).

5.1.2 File structure: the Datastore

Experimental data are written to a results file called a Datastore, which is a proprietary format designed for handling multi-dimension data. Its content will depend upon the type of experiment that is carried out. A knowledge of the structure of Datastores will be helpful in understanding some of the functionality of Pro-Data Viewer.

A Datastore consists of dimensions and properties. The dimensions are the controlled (independent) experimental variables, such as wavelength or time; the properties are the measured (dependent) variables such as CD or absorbance; temperature may be either a dimension or a property, depending on the type of experiment. When data are plotted using Pro-Data Viewer, dimensions are always plotted on the x-axis, and the properties on the y-axis.

A Datastore can therefore have one or more dimensions, depending on the number of controlled variables. For example, a simple experiment in which CD is measured as a function of wavelength would generate a one-dimension Datastore containing wavelength as the dimension, and CD, detector HV, absorbance (if measured), temperature, the detector signal voltage (DC component), and the number of samples taken (count), as properties.

If a temperature ramp is performed in which a series of spectra are measured while the temperature is changing, in a single experiment, a two-dimension Datastore would result, with wavelength and temperature as dimensions, and containing CD, HV etc. as properties. A titration experiment, in which a spectrum is measured at each of a series of concentrations, would also generate a two-dimension Datastore, in this case containing properties as functions of wavelength and titrant concentration.

Higher dimension Datastores can also be generated. If a stepped temperature ramp is carried out using the CS/PCM 4-cell autochanger, then cell position becomes a third dimension and the Datastore contains properties as functions of temperature, wavelength and cell position. Substituting time for temperature would result in a Datastore containing properties as functions of wavelength, time and cell position.

All data from a particular experiment are written to a single Datastore. Subsequently, the Datastore can be mined for subsets of the data.

Note that the Datastore file format is designed for Pro-Data multi-dimension data acquisition and is not suitable for direct access outside the Pro-Data environment. A range of file export options is provided within Pro-Data, generating formats that are suitable for third-party applications.
5.1.3 Viewing experimental conditions
Experimental parameters (wavelength range, step size, time-per-point, bandwidth) plus sample information provided by the user via the Setup... dialog box in the spectrometer control panel (sample description, concentration, cell type and pathlength) are stored with the results file and can be viewed on the Datastores Details View, the area to the bottom of the launchpad (Figure 5.2). The details shown will be those of the file highlighted in the launchpad file list.

5.2 Displaying and selecting data
5.2.1 The graphical display
One or more files can be displayed in the graphical display

- To display a single file double-click on the filename or choose Open from the File menu (Section 5.7.1).
- To add a file to the graphical display, drag it onto the display or right-click and choose Add DataStore to Graph.
- To add more than one file at a time, select multiple files from the list in the usual way (using the mouse pointer with Ctrl or Shift keys) and drag them onto the graphical display (Figure 5.3).
- To display a file in a new window, double-click on the filename or choose Open from the File menu (Section 5.7.1).
- To remove a spectrum from the display select the trace (Section 5.2.2), right-click and choose Remove Selected Trace or use the Trace manipulation dialog box (Section 5.3.1).
5.2.2 Selecting a spectrum in the display

A spectrum can be selected in a number of ways. Once selected, it changes colour to black, is highlighted with ‘selection marks’ and cross-hairs appear on it. The value of the x- and y-coordinates at the position of the cross hairs are shown above the graph (Figure 5.4). Single spectrum selection methods are listed below.

- Place the mouse cursor close to the trace of interest. Left-click to select it. Click a second time to deselect it.
- Right-click anywhere in the display window to reveal a pop-up menu. Choose Select Specific Traces to open a dialog box containing a list of the spectra displayed. Click on a filename to select it and OK to close the dialog box.
- On the Trace menu click Selection Dialog to open the Trace Manipulation dialog box (Section 5.3.1). Click on a filename to select it and OK to close the dialog box.
- From the toolbar, click on the icon to open the Selection dialog box. Click on a filename to select it and OK to close the dialog box.

Figure 5.3: two files selected in the launchpad and dragged onto the display
Figure 5.4: CD spectrum of lysozyme with background selected.

The method of selection will depend on personal preference and on the number of spectra displayed. For example, if you wish to select one spectrum from several overlapping spectra, using the dialog is easier than using the mouse pointer. Once a spectrum is selected, the **Up / Down** arrow keys can be used to move the selection sequentially through the displayed spectra.

5.2.3 Selecting more than one spectrum

Selecting more than one spectrum or trace is often required, for example to average several spectra. Variations in the methods described in the Section 5.2.2 to select a single spectrum are used to select more than one.

- When using the mouse pointer to select spectra, hold down the **Shift** key and click on the spectra of interest. Clicking on the same spectrum twice with the Shift key depressed will first select it and then deselect it.
- When selecting from the drop-down list, hold down the **Shift** key and click on the filenames of interest. Clicking on the same filename twice with the Shift key depressed will first select it and then deselect it.
- When selecting from the **Trace manipulation** dialog box (Section 5.3.1), use the Ctrl and Shift keys in combination with the mouse to select filenames in the usual way. Selected files are highlighted. In general, using the dialog box is the preferred method when dealing with more than one spectrum.

5.2.4 Zooming and re-scaling the display using the mouse

To zoom in to a particular part of the display, click and hold the left mouse button while moving the pointer to create a box around the area of interest. On releasing the left mouse button, the newly created box will expand to fill the display window (Figure 5.5). To return to full display, double-click in the display area.
Use the mouse wheel to expand or contract both axes simultaneously. Hold down the Ctrl key and use the mouse wheel to expand or contract only the horizontal axis. Hold down the Shift key and use the mouse wheel to expand or contract only the vertical axis (Figure 5.5).

The zoom functions can be used in any combination. To return to the default full-screen display, double-click at any time in the display area.

5.2.5 Displaying different properties
Pro-Data Viewer always plots the dimension on the x-axis, and the selected property on the y-axis. Right-clicking the y-axis legend will display a menu of the properties recorded during a measurement (Figure 5.7). To change the property displayed, select one from the list by double-clicking it.
When run in CD mode, five properties are recorded with every measurement made on the Chirascan. These are:

- Circular dichroism
- HT (i.e. HV, detector high voltage)
- Voltage (a record of the actual detector DC voltage achieved)
- Temperature at which the measurement was taken
- Count (the number of 25 µs samples taken at each step in the scan)

In addition, the Absorbance can be plotted if it was selected when setting the experimental conditions and a background has been run (Figure 5.8), and the Fluorescence can be plotted if it was selected and a fluorescence detector was fitted (see the Fluorescence Accessories User Manual).

![Figure 5.8: absorbance spectra for water (red) and lysozyme in water, relative to N2](image)

### 5.3 Manipulating, Fitting and Converting data

#### 5.3.1 Trace Manipulation

The Trace Manipulation dialog box (Figure 5.9) can be opened by clicking Selection dialog on the Trace menu (Section 5.8.3) or by clicking on the graphical toolbar (Section 5.6.2).

The dialog box is an environment in which data (traces) can be background corrected, averaged or otherwise manipulated. All operations carried out within this environment are reversible, which means that if errors are made they can be quickly and easily corrected. The original data are never over-written or otherwise destroyed and all operations carried out on data are recorded in the History file on the View menu (Section 5.7.2). The results of the manipulations are displayed in real-time and can be saved at the end of the session in one of a number of formats using Save current plot on the File menu (Section 5.7.1).
The structure of the dialog box is straightforward. There are two windows, one of which lists any traces that are visible in the graphics window, the other listing those that have been removed from the display during the session and are no longer shown in the display. The buttons on the right execute actions on traces that have been highlighted in the Visible Traces window. Traces can be swapped between the Removed Traces and Visible Traces window using the arrow buttons between the two panes. Single arrow will move a selection, double arrow will move all listed traces.

In the example below, there are six traces (3 repeat backgrounds and 3 repeat lysozyme spectra). We will average the backgrounds, average the spectra, subtract the average background from the average spectrum, smooth the resulting background-corrected lysozyme spectrum and remove the original data. The end result will show the lysozyme spectrum and its residual (calculated minus observed spectrum).

With the data loaded into the display as previously described, and the graphical display active, open the dialog box to display the data files list (Figure 5.10).

![Figure 5.9: the Trace Manipulation dialog box](image)

![Figure 5.10: raw data with dialog box called up](image)
The first three files are backgrounds; the second set of three are the lysozyme spectra.

1. Select the first group of three files and click **Average**.
2. Select the second group of three files and click **Average**.

Two files named AVERAGE xxxxxxxxxx with identifying numbers taken from the computer timer will be added to the **Visible Traces** list and plotted in the display. The first of these will be the average of the backgrounds, and the second the average of the lysozyme spectra.

3. Select the first AVERAGE file and click **Set Background**.
4. Select the second AVERAGE file and click **Subtract Background**.

The file SUBTRACTED……………. (background subtracted spectrum) will be added to the **Visible traces** list and plotted in the display.

Select the SUBTRACTED……………. file and click **Smooth**. The **Smoothing** dialog box will appear (Figure 5.11).

![Figure 5.11: An appropriate smooth (left) and an inappropriate one (right)](image_url)

Enter the number of degrees of smoothing required in the **Window Size** box. This value will depend on the step resolution used during the measurement and the sharpness of the features in the spectrum. The number should be as large as is possible without causing distortion of the spectrum. Examination of the residual plot will show if any distortion has occurred. If the noise is randomly distributed about zero, the smoothing process has not caused any distortion and, importantly, you have the evidence to prove it.

An example of an appropriate smooth, in which 5 degrees of smoothing were used, and an inappropriate one, in which 12 degrees of smoothing were used on the same data set, are shown in Figure 5.11. The structure in the residuals that arises when 12 degrees of smoothing were used is apparent.

When you are satisfied with the smoothing process, click **OK**.
1. Click **Unset Background**.
2. Select Smooth (s)……………… and Smooth (r)……………… and click **Remove Others**. The Trace manipulation dialog box will appear as in Figure 5.12.

![Trace manipulation dialog box](image)

Figure 5.12: Trace manipulation dialog box after spectrum manipulation

Click **OK** to close the dialog box. The result of the above manipulation is shown in Figure 5.13, with the smoothed and background corrected spectrum of lysozyme and the smoothing residuals plotted.

![Smoothed and background corrected spectrum](image)

Figure 5.13: smoothed and background corrected spectrum of lysozyme (red) and smoothing residuals (blue)

Note that even after closing the **Trace Manipulation** dialog box, any removed traces are remembered. Should you wish to carry out further manipulation, simply re-open the dialog and all the traces will be listed, whether visible or removed, enabling you to carry on where you left off.
5.3.2 Curve Fitting

Select the curve you want to fit and open the **Curve Fitting** dialog box using by choosing **Fitting** on the Math menu (Section 5.8.4), on the graphical display toolbar (Section 5.6.2), or the **Fit** button on the **Trace Manipulation** dialog box (Section 5.3.1).

![Curve Fitting Dialog Box]

Figure 5.14: hydrolysis of glucuronolactone with potassium hydroxide

A selected function is fitted to the data using a Marquardt-Levenberg algorithm. Select the required function form the dropdown list on the **Fitting Parameters** panel and enter the range over which the data are to be fitted on the **Fit Range** panel, then click **Set** to update. If you are unsure about initial starting parameters for the fit, click the **Estimate** button to automatically generate a set of initial parameters, which may not be very accurate. The curve associated with these parameters is plotted in the preview window to the right.

To initiate the fitting of the parameters to the data, click **Fit**. The algorithm will iterate until convergence or the maximum number of cycles is reached. If the fitting is successful, the parameters will be updated and the calculated curve plotted in the preview window. The associated residual trace (the difference between the observed and calculated data) will be displayed in the **Residuals** part of the preview window. The errors associated with the calculated parameters are displayed next to the calculated parameters. You will be able to judge the quality of the fit by inspecting the residual trace and the parameter errors. If the errors are large compared with the parameters, then it is likely that you have specified a fitting function which is more complicated than is justified by the data, i.e. the result is under-determined. The number of variable parameters can be reduced by locking any parameter using the check boxes adjacent to the parameters, but such locking must be justified and should be applied with care.

If the fitting process does not converge within the selected maximum number of iterations, a warning is given. You may wish to increase the number of iterations, up to a maximum of 1000. Be aware that 1000 iterations of
the fitting algorithm may take some time. In some instances, the fitting does not converge because of the absence of a unique solution. This too is symptomatic of an under-determined model.

When you are satisfied that the fit is a good one and the calculated parameters are sensible, you can print out a report by clicking on the printer icon. The report displays the data, the calculated fit data with residuals and the associated fitting parameters.

To plot the fitted curve in the Pro-Data Viewer display, click **OK**. If you do not wish the residuals to be included on the plot, clear the **Include Residuals in Final Plot** check box.

5.3.3 Converting CD Units

Select the traces whose units you wish to convert and open the **Convert CD units** dialog box using **Convert** on the **Math** menu (Section 5.8.4), on the graphical display toolbar (Section 5.6.2), or the **Convert** button on the **Trace Manipulation** dialog box (Section 4.3.1).

![Figure 5.15: the Convert CD units dialog box](image)

The CD units of the selected trace are shown in the **Convert From** box; the units you wish to **Convert To** are chosen from the drop-down menu.

When converting between millidegrees (mdeg) and delta A, a scaling factor is used and the conversion requires no further input. When converting from mdeg or delta A to units that are normalized in some way, further input is required.

To convert to molar delta A or molar ellipticity the calculation normalizes for (and therefore requires knowledge of) the molarity of the solution and the pathlength of the cell (cm) (Figure 5.16).
For proteins, it is usual to normalize for the number of amino acid residues as well as concentration and pathlength. When Mean residue molar delta A or Mean residue molar ellipticity are selected, the input required is the concentration of the protein (mg/ml), the pathlength of the cell used (cm) and the mean residue molecular weight. The default input for the Residue MW is 113, a commonly accepted value for the mean molecular weight of an amino acid residue. This default value can be changed if required. The units are presented in this way to make it possible for proteins that are not yet fully characterized to be normalized for comparative purposes.

5.3.4 Saving data
The manipulated data are not saved automatically. To save the result, go to Save Current Plot… on the File menu (Section 5.7.1) to call up the Save As… dialog box or Save selected traces on the File menu. The original raw data are never over-written. The results of any manipulation are stored in a new Datastore and a complete history of the manipulated traces is contained in the History of that Datastore which is opened on the View menu (Section 5.7.2).

5.4 Exporting data
Right-click on a filename in Pro-Data viewer launchpad to display the File manipulation pop-up menu shown in Figure 2.19.
Select **Export data**... to bring up the dropdown list in Figure 2.20 and choose an appropriate format for export to another program. CSV format is suitable for third-party programs such as Excel; other options relate to formats derived from other APL products.

![Export Data](image)

Figure 5.18: options for exporting data

### 5.5 Handling multi-dimension Datastores

#### 5.5.1 Loading multi-dimension Datastores

In the example that follows, an experiment was set up to measure a CD spectrum of 1-S-camphor-10-sulfonic acid from 240 nm to 340 nm for each of four cells mounted in a CS/PCM 4-cell auto-changer at temperature intervals of 5°C from 20°C to 80°C. The three independent variables make it a three dimension dataset. Load the file in the usual way from the Pro-Data Viewer launchpad to display a set of CD spectra, one for each temperature, for cell position 1. The Viewer display is subtly different when a Datastore of more than two dimensions is displayed - a slider-bar representing the third dimension (in this case cell position) is added beneath the toolbar (Figure 5.19). The spectra from each cell can be displayed by moving the slider to the appropriate position on the bar.

![Stepped temperature-ramp showing first cell CD spectra](image)

Figure 5.19: Stepped temperature-ramp showing first cell CD spectra.
5.5.2 Changing the display axes  
Right-click on the x-axis legend to display the dimension menu (Figure 5.20).

![Figure 5.20: the dimension menu](image)

In this case wavelength (in the X column) and Temperature (in the Z column) are highlighted, indicating that in the display above, wavelength is the x-axis and the CD spectra at different temperatures are projected down the z-axis onto the display. The third dimension is shown in the slider-bar. To change the display, select a different combination of x- and z-axes from the menu, for example Wavelength and Cell. Temperature will appear as the third dimension in the slider-bar (Figure 5.21):

![Figure 5.21: CD spectrum for each of the four cells at 20°C](image)

Spectra for the four cells can be displayed at any one of the temperatures at which they were measured simply by selecting the temperature from the dimension bar above the display.

Once data are displayed, they can be manipulated as previously described in this Chapter.
5.5.3 Mining multi-dimension Datastores

Multi-dimension Datastores can be mined for subsets of the original data and the subsets saved as new files. The process is recursive, so higher-dimension Datastores can be reduced to their simplest one-dimension forms if required. Below is an example of how to mine a two-dimension Datastore.

Right-click on a two-dimension Datastore in the launchpad file list and select Decompose Data from the menu. A Decompose data dialog box will appear (Figure 5.22).

![Decompose Data dialog box](image)

Figure 5.22: Decompose Data dialog box

In the example, the dialog box shows that the Datastore has two dimensions, wavelength and temperature, and the ranges those dimensions span. To reduce the range of temperatures to 25°C to 50°C, and retain wavelength as the only dimension, input these values into the temperature range boxes, and clear the temperature Primary check box (Figure 5.23).

![Decompose data dialog box](image)

Figure 5.23: Decompose data dialog box

A new one-dimension Datastore will be created containing spectra for every temperature from 25°C to 50°C. Click Save as, name the Datastore, and refresh the launchpad directory tree. The Datastore will be in a new folder created in the original folder.

Three-dimension Datastores can be decomposed in the same way. Figure 5.24 shows the Decompose data dialog box for a three-dimension Datastore.

![Decompose data dialog box](image)

Figure 5.24: the Decompose data dialog box for a 3-dimension Datastore
The number of **Primary** boxes ticked will determine the lowest-dimension Datastore created. In the above example, if all three **Primary** boxes were ticked, a single three-dimension Datastore would have been created, with the range restrictions specified in **Range Min** and **Range Max** fields.

If two **Primary** boxes were ticked, for example wavelength and temperature, a single three-dimension Datastore would have been created, along with a two-dimension file for each cell. If only one **Primary** box was checked, for example wavelength, a single three-dimension file would be created, along with two sets of two-dimension Datastores (with wavelength/temperature and wavelength/cell as the dimensions), each of which would be decomposed into the corresponding one-dimension Datastores.

### 5.6 Pro-Data Viewer toolbar icons

#### 5.6.1 Launchpad toolbar icons

The launchpad toolbar is shown in Figure 5.25. Positioning the cursor over the icon will call up a brief description; a fuller description is also provided in the status bar at the foot of the launchpad.

![Figure 5.25: the launchpad toolbar](image)

- **Define the currently selected directory (folder) as the working directory**
  - i.e. the directory in which any new data files will be stored. The current working directory is always shown in the box immediately above the toolbar icons. The directory name will sometimes need to be contracted to fit in the box but the first and last part of the name are always shown.

- **Returns you to the current working directory**

- **Moves the working directory up one level, to enable you to access files in directories higher up the tree.**

- **Creates a new folder in the currently selected directory.**

- **Opens a browser window from which you can navigate quickly and easily to other folders.**

- **Refresches the directory tree display. This should be done after saving a file following averaging or smoothing, for example, as the live directory is not automatically updated.**

- **Click this icon and then on item of interest to call up the context sensitive help for that item.**
5.6.2 Graphical display toolbar icons

The graphical display toolbar is shown in Figure 5.26.

![Figure 5.26: the graphical display toolbar](image)

Saves all the traces in the display into a new file. Click on this icon to call up the **Save As...** dialog box from where you can specify a filename and choose a location for the new file.

Prints the active document.

Causes an edit box to appear enabling you to record information in addition to that recorded automatically or entered through the Setup… dialogue box in the SCP.

Calls up a history of the operations performed on the trace.

Prints the active document.

Sets a selected trace as a background. Clicking again will reset the trace to its original status.

Adds a previously defined background to a selected trace or traces. It is useful if a background has been subtracted inadvertently from a trace. This icon is inactive if no background has been defined.

Subtracts a previously defined background from a selected trace. This icon is inactive if no background has been defined.

Opens the **Curve fitting** dialog box enabling one of a number of models to be fitted to a selected trace (Section 5.3.2).

Averages the selected traces: the average will be added to the plot.

Averages all the traces in the display, plots the average, and removes the original data.

Opens the **Simple math** dialog box that enables you to add, subtract, multiply or divide a trace to, from or by a constant.

Opens the **Smoothing** dialog box enabling a reversible Savitsky-Golay smoothing operation to be performed on a selected trace. The smoothed trace and (optionally) its residual are plotted (Section 5.3).

Opens the **Convert CD units** dialog box enabling you to convert from the current CD units to others (Section 5.3.3).

Opens the **Trace Manipulation** dialog box (Section 5.3.1)

Opens the **Visible Trace Range** dialog box to reduce the number of traces from the same Datastore that are displayed.
Removes all overlaid traces from the display. An overlaid trace is one whose property and dimension (e.g. CD and wavelength) are the same as those of traces already in the display but whose wavelength range or step-size or bandwidth differs from the originals.

Changes the x-axis to logarithmic scale. Clicking again on the icon will change the axis back to a linear scale. A logarithmic scale is mainly used when time is plotted as the x-axis.

Resets the trace colours to the first available in the palette. This can be useful after trace manipulation if the automatically assigned colours are not suitable, e.g. too pale.

5.7 Launchpad drop-down menus

5.7.1 The File menu

![File menu](image)

Figure 5.27: the File menu

The **File** menu (Figure 5.27) presents the usual Windows options for opening and closing files.

5.7.2 The View menu

![View menu](image)

Figure 5.28: the View menu

On the **View** menu (Figure 5.28)

- **Close all viewer windows** is a quick means of closing all Pro-Data Viewer graphical displays. It is useful if **Single Window** in the Preferences drop-down menu has not been selected.
- **Always on top** is a toggle to force Pro-Data Viewer to be the top window.
5.7.3 The Directory menu

The Directory menu (Figure 5.29) can be used to set the current working directory or to return to it.

- Move Root Directory Up One Level will take you back through the directory tree one node at a time.
- Set working directory will define the currently selected directory (folder) as the working directory.
- Back to working directory will take you directly back to the current working directory.
- New folder will create a new folder in the currently selected directory.
- Browse for folders allows you to browse easily to a folder that can then be set as the working folder.

5.7.4 The Preferences window

The Preferences menu (Figure 5.30) is used to set the conditions for the graphics display and on-line status.

- Single Window when selected means that whenever a new graphical display is opened during data acquisition, all previous ones are closed. If it is not selected, then whenever a new measurement is made, the previous displays are not closed, but will remain open on separate tabs; If you are running an experiment that involves a lot of repeat measurements, it is recommended that Single Window be selected; if not, you could end up with a large number of displays to close. Single Window has no effect when opening files from the launchpad.
- Go On-line will display the Connect dialog box (Figure 5.31) on which you will be asked to supply the Chirascan IP Address. It is used when Pro-Data Viewer has been started as a stand-alone program and you want subsequently to establish a link with the spectrometer control program (SCP). If the two programs are running on the same computer, select Local in the Connect window. The IP address under these circumstances is always the default 127.0.0.1.
The client-server architecture permits remote monitoring of experiments in progress. If a copy of Pro-Data Viewer is installed on a remote computer, establishing a client-server link established using the Remote setting will enable you to follow an experiment on the second computer. The IP address of the Chirascan computer will not be the same as the default local IP address – your network administrator will be able to inform you. If the address is correct and the instrument is running, the Pro-Data Viewer display panel will open. Pro-Data Viewer will ‘listen’ to Chirascan and report its status, behaving as a real-time display. If the address is incorrect, the error message shown in Figure 5.32 will appear.

- **Allow Cary files** allows files imported from some Agilent Cary series spectrometers to be plotted using Pro-Data Viewer.

### 5.7.5 The Help menu

The Help menu (Figure 5.33) gives access to the Pro-Data Viewer launchpad help system.
5.8 Graphical Display drop down menus

5.8.1 The File menu

The **File** menu (Figure 5.34) gives access to the usual Windows file handling options.

![Figure 5.34: the File menu](image)

5.8.2 The View menu

On the **View** menu (Figure 5.28):

- **Aux Dimension Ctrl** is a toggle to show or hide the third dimension slider bar. It is of use when dealing with multi-dimension Datastores.
- **Legend** is a toggle to hide or show the trace names that appear by default at the side of a plot. The function can be more easily executed using the keyboard shortcut L or by right-clicking anywhere in the plot border and clicking on the *Hide legend* or *Show legend* pop-up that appears.
- **Remarks...** calls up an edit box in which you can add comments to supplement information that is recorded automatically or entered through the *Setup...* dialogue box in the SCP.
- **History** shows a history of the operations performed on the file, for example background subtraction, smoothing and fitting.
5.8.3 The Trace menu

Figure 5.36: the Trace menu

On the Trace menu (Figure 5.36):

- **Show Trace Name** is a toggle to show / hide the name of a highlighted trace when the mouse pointer is placed near to it.
- **Selection Dialog** calls up the Trace Manipulation dialog box (Section 5.3.1).
- **Select All** selects every trace in the display.
- **Deselect All** deselects every trace in the display.
- **Remove Selected** removes from the display any currently selected trace. Removed traces can be recovered using the Trace Manipulation dialog box (Section 5.3.1).
- **Remove Others** removes from the display any trace that is not selected. Removed traces can be recovered using the Trace Manipulation dialog box (Section 5.3.1).
- **Toggle Selected as Baseline** sets / unsets a selected trace as a baseline.
- **Add Baseline** and **Subtract Baseline** become active once a baseline has been set and respectively add a baseline to a selected trace or subtract a baseline from it.
- **Remove Overlaid Traces** removes all overlaid traces. An overlaid trace is one whose property and dimension (e.g. CD and wavelength) are compatible with those of traces already in the display but whose wavelength range or step-size or bandwidth is incompatible with those traces already in the display. Overlaid traces cannot be manipulated and are always coloured black to differentiate them from active traces.
- **Recompute Trace Colours** will assign new colours to the traces in the display. This is useful if after manipulation the colours of the traces are not satisfactory.
- **Reset** will undo all operations carried out on the original data and restore the original display.
5.8.4 The Math menu

All mathematical functions can be called up using keyboard shortcuts or toolbar icons.

- **Fitting…** calls up the Curve fitting dialog box.
- **Average** calculates and plots the average of the selected traces.
- **Average All Traces** calculates and plots the average of all the traces in the display. The original traces are removed. Removed traces can be recovered using the Trace Manipulation dialog box (Section 5.3.1).
- **Simple Math…** opens a dialog box that enables you to add or subtract a constant to a trace or multiply or divide a trace by a constant. It can be useful for offsetting one trace from another for display purposes or for normalizing spectra for easier comparison.
- **Smooth…** opens a window for applying a smoothing algorithm to raw data. It allows you to optimize the smoothing before accepting it.
- **Convert…** opens the Convert CD units dialog box (Section 5.3.3). For more information on the Fitting, Smooth and Convert functions, see Section 5.3.

5.8.5 The Scale menu

On the Scale menu (Figure 5.38):

- **Set Plot limits…** calls up a dialog box that enables you to set the limits for the x- and y-axes.
- **Reset Zoom** resets the scale to the original display size. Double left-clicking anywhere in display window will achieve the same thing.
- **X Logarithmic** will change the x-axis to a logarithmic scale. This feature can be useful for kinetic data.
5.8.6 The Window menu

On the Window menu (Figure 5.39):

- **New Window**…  up a list from which can be selected the desired property. The new window will be displayed at the same time as the original window in a tile format.
- **Close** will close the currently active window.
- **Cascade** will display in a cascade format all property windows (e.g. CD, absorbance, HT) that have been opened and are not currently minimized.
- **Tile** will display in a tiled format all property windows (e.g. CD, absorbance, HT) that have been opened and are not currently minimized.
- **Arrange icons** will tidy up any minimized property displays that have been strewn around the display window.
- **1, 2 etc. refer to the open windows: the displayed window is identified by the tick icon**
- **Windows**… opens a dialog box that enables you to activate or close displays selected from a list.

5.8.7 The Help menu

The Help menu (Figure 5.40) gives access to the ProData help system.
5.9 **CD background subtraction theory**

Residual birefringence in the photocathode of the detector and the sample cuvette means that a non-zero CD background is always present, and that its contribution will add to that of the sample. The systematic error introduced by residual birefringence in the system can be legitimately corrected by measuring it using a blank, and then subtracting the background from the total CD spectrum of residual birefringence plus sample. The true CD spectrum of the sample will then be revealed.

However, random noise exists on any measured background or spectrum and such random noise can create problems for the unwary. If a background is measured and then subtracted from a series of spectra which are subsequently averaged, the noise in the result will be overly influenced by the noise in the background. Consider:

\[
\delta x_1 - y \\
\delta x_2 - y \\
\delta x_3 - y \\
\delta x_4 - y \\
. \\
. \\
. \\
\delta x_N - y
\]

where \(\delta x_i\) represents the random noise deviation from the underlying spectrum and \(y\) represents the random deviation from a single background. Taking the average of the deviations:

\[
\frac{1}{N} \left( \sum_{i=1}^{N} \delta x_i - Ny \right) = \frac{1}{N} \sum_{i=1}^{N} \delta x_i - N
\]

As \(N\) tends to infinity, \(\Sigma \delta x_i\) tends to zero and the noise in the background-subtracted, averaged spectrum becomes the noise in the background itself. Of course, if a separate background were to be measured for every spectrum, this problem would not occur.

![Figure 5.41: multiple lysozyme spectra](image)
There are approximately 400 spectra of lysozyme in Figure 5.41. The experiment was to monitor the photolysis of the protein over time. Each spectrum was measured in about 90 seconds. The secondary structure changes with time and it is therefore not appropriate to average the spectra, but we are interested only in the random noise on the spectra. Noise can be separated from a spectrum by smoothing the spectrum and keeping the residual (raw data – smoothed data). Taking the average of the residuals is a valid operation and shows that the random noise is dramatically reduced by the process of averaging (theory tells us that a 20-fold improvement in signal to noise ratio (S/N) would be expected from averaging 400 observations).

![Figure 5.42: smoothing residuals (left) and their average (right)](image)

Repeating the above process with a single background subtracted from each spectrum prior to generating the residuals yields a quite different picture. The average residual (noise) is, to all intents and purposes, identical to the single background residual.

![Figure 5.43: single-background-corrected residuals (left) and their average (right)](image)
The improvement in S/N inherent in averaging is lost, and worse, any artifact in the background would be reinforced in just the same way as the random noise is, and there is thus a danger that any such ‘feature’ could be misinterpreted as real.

In order to avoid the impractical and tedious business of measuring a separate background for every spectrum, smoothing the background prior to subtracting it from a series of spectra will eliminate the problem. A background should not have any ‘sharp’ features in it and can therefore be smoothed considerably without introducing any artifacts; if it does have features, it is likely that the cell was not cleaned properly or some other artifact has crept into the measurement and it should be discarded and measured again.

Repeating the above procedure with a single, smoothed background subtracted from the spectra prior to calculating the residuals takes us back to the correct result (Figure 5.44).

Figure 5.44: single, smoothed-background-corrected residuals (left) and their average (right)
5.10 Using CDNN to calculate the secondary structure of proteins.

CDNN is a third-party program that is included with Pro-Data Viewer by permission of its author, to assist users in calculating protein secondary structures. Any publication of results calculated using CDNN should refer to the author (see the CDNN manual on the installation disk for details). Details of the program and its operation are given in the CDNN Help system, and the user is advised to use those guidelines in conjunction with those given here.

5.10.1 Getting started

Launch the CDNN software using the desktop icon. You will be presented with the Simple Spectra dialog box (Figure 5.45).

![Figure 5.45: the Simple Spectra dialog box](image)

From the File menu select Open. On first use, the program will open at the Sample Files folder, Figure 5.46 (C:\Program Files\Applied Photophysics\CDNN\Sample Files).

![Figure 5.46: the Sample Files folder](image)
Select one of the sample files and click **Open**. Here, the Lysozyme example file **Lysozyme.txt** is used. The **CD Signal type** dialog box appears, asking the user to select the CD signal type (Figure 5.47).

![Figure 5.47: the CD Signal Type dialog box](image)

All the examples in the **Sample Files** folder are converted to Delta Epsilon, the differential extinction coefficient (in this case further normalised for the number of amino acid residues, discussed in Section 5.10.3). Click **OK**. The panel will disappear, returning you to the **Simple Spectra** dialog box. Click **Deconvolute** to calculate the contributions of the various components to the protein secondary structure (Figure 5.48).

![Figure 5.48: calculated components of the secondary structure of lysozyme](image)
The example given here is that of lysozyme (Sample Files>Lysozyme.txt). The units, delta epsilon, are per amino acid residue. Once you are familiar with the use of the program and what the results mean (it is recommended that you read the notes that come with the program itself), move on to your own samples.

5.10.2 Using CDNN with your own results

Measure the CD spectrum of your protein and carry out any manipulations, such as averaging, background correction and smoothing. (background correction is essential to get reasonable results). Here we use the example of Lysozyme.

Figure 5.49: Lysozyme and background spectra, several repeat measurements

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Concentration</td>
<td>0.2 mg/ml</td>
</tr>
<tr>
<td>Pathlength</td>
<td>0.5 nm</td>
</tr>
<tr>
<td>Molecular weight</td>
<td>14600 daltons</td>
</tr>
<tr>
<td>Amino acid residues</td>
<td>129</td>
</tr>
<tr>
<td>Wavelength range</td>
<td>180 – 260 nm</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>1 nm</td>
</tr>
<tr>
<td>Step size</td>
<td>0.5 nm</td>
</tr>
</tbody>
</table>

Table 5.1: operating conditions for the spectra shown in Figure 5.49
CDNN requires a text-file input format, with wavelengths and associated CD values at 1 nm intervals. It does not matter if you have measured the spectrum at a different step-size (the above spectra were measured at 0.5 nm steps) because there is a conversion program that generates the correct input format. Select **File>Save Selected Traces** from the graphical display **File** menu (Section 5.8.1) to call up the window shown in Figure 5.51, and choose **CDNN (*.txt)** from the drop-down list under **Save as type.** Specify a filename and location and click **Save.**

Launch CDNN as previously described and open the file that you have just saved. This example uses the lysozyme data described above. Unlike the examples in the **Sample Files** folder, these CD data are in millidegrees. Care is needed to ensure that the results are meaningful.
With **Millidegrees** selected, the **Essential Parameter** panel appears (Figure 5.52). It is important that the information requested is supplied. For lysozyme measured under the conditions given above, the fields are correctly filled in. Click **OK** and then **Deconvolute**.

The results will appear in the **Deconvolution** window (Figure 5.53).

Comparison of the example and original data will show that the results are broadly similar. There are small differences in the spectra and it is not therefore surprising that there are small differences in the calculated contributions of the various secondary structure components.
5.10.3 Dealing with uncharacterised proteins

Not all proteins are well characterised; for example, the molecular weight may not be known. Fortunately that does not prevent you from determining the secondary structure components. It is sufficient to replace the molecular weight of the protein with the average molecular weight of the amino acid residues (generally accepted to be about 113) and to replace the actual number of amino acids with the number 1 (Figure 5.54).

![Figure 5.54: the CD Signal Type dialog box for an uncharacterised protein](image)

Click OK and Deconvolute to generate an identical result to that using the correct molecular weight and the correct number of amino acid residues.
6 TECHNICAL OVERVIEW

6.1 Key technical features

6.1.1 The subsystems

The key technical features of the Chirascan spectrophotometer are:

- Dual polarising prism optics with digital drive and calibration
- High throughput F/7 optical coupling
- Rapid and economical nitrogen purge design
- High performance digital signal processing of raw data
- Expandable modular electronics
- High speed real-time control
- Client-server Windows software which supports remote monitoring of experiments in progress
- LAAPD based detector system (Chirascan-plus)

![Diagram of Chirascan subsystems]

Figure 6.1: Schematic of the relationship between the Chirascan subsystems
The schematic diagram of spectrometer in Figure 6.1 illustrates the relationship between the three subsystems of the instrument: the optical train, the control and acquisition electronics, and the spectrometer Windows software. The optical train is described more fully in Section 6.1.2 of this Chapter, the control and acquisition electronics in Section 6.1.4, and the Windows software in Chapters 4 and 5.

6.1.2 Optical train

A schematic of the Chirascan series spectrometer optical train is shown in Figure 6.2.

---

The standard light source is a 150 watt ozone producing xenon arc lamp, although other options are also available (Section 3.4). An optimised ellipsoidal focussing mirror (M1) ensures maximum efficiency and light capture. The lamp housing accommodates a pre-aligned lamp assembly for easy lamp replacement.

The monochromator features a dual polarising prism design. This yields pure, linearly polarised monochromatic light and allows high spectral bandwidths in the far UV. The digital drive system uses a stepper driven cam with digital calibration and active temperature compensation. Three coupled, high precision slits are driven by a second stepper motor and a third is used to control a variable aperture/shutter.

The entire monochromator assembly is sealed, with strategically placed nitrogen purge inlets and outlets. This enables the interior atmosphere to be replaced with nitrogen rapidly and effectively, and also allows the nitrogen atmosphere to be retained for long periods after use.

F/7 optical coupling is maintained throughout the optical path. This has been chosen to maximize light throughput without compromising focussing performance.

The linearly polarised monochromatic beam that emerges from the exit slit of the monochromator is then re-focused down through the photo-elastic modulator (PEM). This device, which acts as a dynamic quarter wave plate [1], modulates the beam into alternately left and right circularly polarised states.

---

**Figure 6.2: schematic of the spectrometer optical train**
The modulated beam then passes into the sample handling unit. It passes through the sample block/cell holder and then on to the photomultiplier (PMT) or large area avalanche photodiode (LAAPD) CD detector. The standard detector port is in line with the beam but a second port is available at the rear of the housing. This may be used to accommodate a detector for simultaneous fluorescence detection or fluorescence detected CD (FDCD).

Two bulkhead access plates are fitted to allow other accessories to be placed in the light tight sample handling unit. These include a Peltier temperature controller (CS/PCS), a 4-cell autochanger (CS/PCM) and a titration accessory (CS/TT) as well as devices of the user’s own design. Removable sample holders are provided as standard with the CS/PCS to accommodate a variety of square and circular sample cells. Up to four temperature sensors can be monitored, and magnetic stirrer support can be added as an option.

The sample handling unit has been designed to accommodate large specialist cell holders and accessories, for example cryostats and electromagnets for magnetic CD (MCD) experiments. However, in exceptional circumstances the entire housing can be straightforwardly removed and an alternative sample handling system configured, for example to install the CS/SF stopped flow accessory.

A ‘lid open’ detector is fitted as standard which will pause an experiment in progress and reduce the photomultiplier high voltage to prevent damage if the lid is raised.

6.1.3 The LAAPD detector (Chirascan-plus only)

The feature that distinguishes the Chirascan-plus from the standard Chirascan is the solid-state large area avalanche photodiode (LAAPD) CD detector that replaces the photomultiplier tube (PMT) detector on the standard instrument.

Avalanche photodiodes are effectively the solid-state equivalents of photomultiplier tubes. Using a high reverse bias voltage the detectors exhibit a high internal gain, in the same way that high voltages to photomultiplier anodes boost the internal gain of photomultipliers.

Large area avalanche photodiodes are a new generation of APDs with features that make them high performance replacements for photomultipliers for many applications. These features include a large light collection area similar in size to photomultiplier photocathodes, higher quantum efficiency than photomultipliers, extended wavelength range sensitivity, and rugged construction and high internal gain.

The LAAPD detector on the Chirascan-plus is a 1 cm diameter round detector, windowless silicon APD. The detector shows a higher quantum efficiency (i.e. a higher number of displaced electrons for each incoming photon) throughout the wavelength range than the PMT used on the standard Chirascan. As CD is a photon shot noise limited measurement [2], the increase in quantum efficiency of Chirascan-plus provides an approximately two-fold signal to noise gain over the Chirascan in the UV region. This extends to several order of magnitude in the near IR region, effectively extending the wavelength range of the instrument into the near IR. The windowless design removes a possible source of birefringence, reflective light loss, and absorbance losses of light in the far UV.
The LAAPD detector has a maximum internal gain of 250. This is in comparison to the $1 \times 10^6$ maximum internal gain of the Chirascan PMT. To provide a similar level of total gain and fine grained gain control to the Chirascan, the Chirascan-plus detector has an output stage of multiple cascading low noise programmable gain amplifiers, which provide 16 bit control giving an amplification gain from 0 to 4096 in 65536 gain levels. Combined with the internal gain of the LAAPD of 200 to 250, this gives a maximum gain of about $1 \times 10^6$. The amplifier gain is recorded and reported by the software as an emulated HV, providing consistency and transparency in the user interface between the Chirascan and Chirascan-plus. The relationship between the Chirascan-plus amplifier stage gain and the emulated HV is shown in Figure 6.4.
Dark-current in the LAAPD detector is autocorrected within the electronics and software. At the start of data acquisition, when the autoshutter is closed, a dark current measurement is made and a correction factor set. This backoff is automatically adjusted by monitoring changes in the temperature of the photodiode, and using a temperature correction factor to adjust the dark current correction factor.

High levels of light hitting the detector will produce a high signal current. Sustained high levels of light produce a large current that can overload the photodiode element. To prevent this the internal gain of the detector can be reduced by lowering the reverse bias voltage. This has been set to a level to allow safe operation of the instrument at a 2 nm spectral bandwidth by the APL production department. As a precaution, the electronics can detect an excess light condition, warning the user and turning off the detector reverse bias voltage to reduce the internal gain.

6.1.4 Control and acquisition electronics

When the modulated light beam strikes the CD detector it is converted into a photocurrent proportional to the incident light flux. Since the beam polarisation is circularly modulated at 50 kHz, a differential transmission of the two states (as would be caused by CD in the sample), results in a 50 kHz AC component superimposed on a background steady state DC component.

The CD is calculated from the ratio of the AC and DC components since CD (in terms of \( \Delta \lambda \)) is given by [2, 3]:

\[
\Delta \lambda = (A_L - A_R) \propto (I_R - I_L) / (I_R + I_L) \propto V_{AC} / V_{DC}
\]  

(6.1)

where \( \lambda \) is the absorbance of the circularly polarized light and \( I \) is intensity, the subscripts \( L \) and \( R \) referring to left and right respectively. \( V_{AC} \) is the AC voltage, and \( V_{DC} \) the DC voltage.

The CD may also be expressed in millidegrees, the unit of ellipticity (\( \theta \)). The two units can be converted according to the formula:

\[
\theta \text{ (millidegrees)} = 32982 \times \Delta \lambda
\]  

(6.2)

The system electronics communicate via a proprietary digital backplane that can support several acquisition and control modules, all operating independently and, if required, simultaneously, with no loss of data throughput (bandwidth). Digital signal processors on all modules are responsible for managing data and decoding and executing commands from the PC.

Two dual stepper control modules are used to drive the monochromator cam, slits and attenuator. Additional modules can be fitted to allow simultaneous fluorescence acquisition or the control of sample handling accessories such as stirrers. Any additional signal acquisition channels will operate in parallel with existing ones so that sampling frequency is not compromised in multi-channel configurations. The Comms module, which is the interface of the electronics to the USB link to the computer, also provides several extra inputs for analog temperature probes and general-purpose digital I/O. Vacant backplane slots are available for future expansion.

All incoming signals (CD AC, CD DC, fluorescence etc) are digitised at a minimum sampling period of 10 \( \mu \)s (100 kHz). Signals are 1 kHz bandwidth limited to prevent noise aliasing but are not otherwise filtered in the analog domain. This is to prevent the risk of irreversible distortion of spectral features which can arise by the incorrect selection of such smoothing filters when the raw input signal is changing too quickly.

The modular design of the electronics means only required features need be installed and any faults that develop are localised and can be easily repaired by substitution of the appropriate module. All modules have a built in
self-test capability which communicates any operational problem to the user, and flash memory is used to allow all onboard signal processing firmware to be upgraded via the computer.

6.2 Chirascan Windows software

Communication between the computer and instrument is carried out over a high-speed USB link. A purpose designed PCI interface card and driver handles the bi-directional communications and data capture.

6.2.1 Signal processing

Data smoothing during spectral acquisition is provided by user variable digital signal averaging. This is applied to the incoming digitised signals at each wavelength of measurement. Each resulting averaged data point (which may be the result of many thousand individual samples) will represent accurately the raw input signal value, since all samples are collected at the same wavelength. A dedicated high-speed averaging algorithm in the driver software carries out the necessary accumulations and computes the averaged result for all monitored signals. The operator is able to select the overall sample size. This is most usefully presented as the time spent at each spectral wavelength (time-per-point). This time will have a direct bearing on the overall scan time and the signal to noise ratio of the result, but will never cause a systematic distortion of the kind that can be caused by the use of analog filtering.

6.2.2 Application software architecture

Figure 6.1 shows the architecture of the spectrometer application software. The object-oriented design has several benefits particularly from the points of view of maintenance, reliability and future expansion. It also allows the same overall architecture to be tailored to different APL products providing a consistent look and feel across the range.

A feature central to the whole instrument control and acquisition process is the Datastore. This ‘object’ provides a blueprint for experimental data collection and also becomes the data storage object after acquisition. In its simplest form it may simply be constructed for a CD spectrum, containing the wavelength range required and a time-per-point parameter etc, but in CD titrations it will also contain a dimension describing the concentration range to target or for a temperature ramp the temperature set points for each measurement. It will also indicate whether simultaneous fluorescence or absorbance are to be measured.

The Datastore is designed to be multidimensional and expandable so that if new measurement variables arise it can expand to accommodate them. If new devices are added, a fluorescence emission monochromator for example, this can be integrated quite easily.

The Spectrometer Control Panel provides the user interface for setting up and executing an experiment. It is this part of the software with which the spectrometer user interacts. During the set up process, a new Datastore object is created which describes the experiment, which then drives the acquisition and is used to accommodate the captured data.

The resulting Datastore object is self-contained and forms the basis for the data storage on disk. Since the Datastore drives the acquisition a Datastore file on disk can itself be trivially used to initiate a new and identical acquisition, by dragging it onto the spectrometer control panel. All the settings derived from the Datastore are automatically transferred to the control panel configuration.

Data visualisation and management is carried out with the Pro-Data Viewer program. Client-server architecture means this can operate either on the host computer alongside the control panel or on a remote networked computer. This allows experiments in progress to be monitored remotely from the instrument, at another location.
The data is transferred to Pro-Data Viewer automatically during acquisition so that the experimental measurement appears in real-time. On completion the new data can be saved on the PC running the linked viewer, though a backup is always stored on the host PC as well.

Once data are collected, Pro-Data Viewer can be operated independently of the control panel software for navigating amongst data files and performing a range of visualisation and data processing operations (see Chapter 4).

A range of detailed device windows can be accessed on the host PC for diagnostic purposes. These are not usually required during normal operation and in some cases are password protected to prevent unauthorised interference (as calibration data and motor drive parameters can be modified). They are provided to allow complete instrument control on site by APL personnel and to allow tests to be run by customers under APL supervision.

6.3 Simultaneous calculation of absorbance and CD

6.3.1 Introduction

The simultaneous measurement of absorbance during a CD measurement is a useful and important facility on the Chirascan series spectrometers. The absorbance spectrum provides an indication of the transmission of the sample and any solvents present, over the wavelength range under investigation. This is helpful in judging whether a CD measurement is valid, since a lack of light throughput will directly result in an erroneous CD, due to the attenuation of AC and DC signals to meaningless levels. This will usually manifest itself as a marked rise in the noise on the CD spectrum, but this alone may not, at first glance, indicate the degree of deterioration in the validity of the measurement. This is particularly problematic in the far UV region of the spectrum where many buffers are opaque, but CD information is of particular interest (e.g. for the secondary structure analysis of proteins). The absorbance of many common buffers and salts rises very sharply below 200 nm and this ‘wall’, which is clearly evident in the absorbance spectrum, indicates, to a first approximation, the wavelength limit of detection.

The absorbance spectrum of the sample is obviously a useful measurement in its own right and is a useful supplement to the CD spectrum. As a general rule, optimal CD measurements are obtained when the sample absorbance in the cell is between about 0.8 and 1.0 AU. [2]. If the absorbance is too low, the CD signal will be weak; if it is too high, insufficient light will reach the detector. The absorbance spectrum also provides a measurement of the sample concentration and indeed can be used to calculate sample concentration given the observation cell pathlength. This will enable accurate molar ellipticity and molar extinction values to be calculated.

An important ratio known as the $g$-factor, or disymmetry factor, which is the ratio of the CD to the absorbance, can also be obtained:

$$g = \frac{\Delta A}{A} = \frac{\Delta \varepsilon}{\varepsilon_M}$$  \hspace{1cm} (6.3)

$\Delta A$ is the measured CD, $A$ the absorbance measured under the same conditions, $\Delta \varepsilon$ is the molar CD and $\varepsilon_M$ the molar extinction coefficient, i.e.

$$A = \Delta \varepsilon . c . l$$ \hspace{1cm} (6.4)

$$A = \Delta \phi_4 . c . l$$ \hspace{1cm} (6.5)
Where \( l \) is the cell pathlength in cm and \( c \) the sample concentration in mol dm\(^{-3}\). The \( g \)-factor is a particularly useful quantity when estimating or assessing enantiomeric excess [4].

### 6.3.2 Absorbance measurement

The simultaneous measurement of absorbance and CD is complicated by the mechanism by which CD signals are optimized on Chirascan series spectrometers. Absorbance is normally calculated according to:

\[
A = \log \frac{T_{\text{REF}}}{T_{\text{SAMPLE}}}
\]

(6.6)

\( T_{\text{REF}} \) is the light transmission with no sample, only solvent, in the observation cell (this is often referred to as 100% transmission or \( T_{100} \)). \( T_{\text{SAMPLE}} \) is the transmission with sample in place. For an absorbance spectrum, first the solvent transmission is scanned (the background) followed by the sample, to yield corresponding reference and sample transmissions at each wavelength. The absorbance spectrum is then simply calculated as the log-ratio for each data pair.

It is essential for this calculation to be valid that the two separate measurements are taken under identical conditions of detector gain (constant photomultiplier high voltage or LAAPD amplifier gain stage).

However this constraint does not apply to CD backgrounds and spectra because CD is a self-referencing measurement (the AC/DC ratio is available from a single scan). The means the detector gain can be automatically adjusted on-the-fly to optimize the signal levels and allow the most accurate and low-noise CD measurements, whether backgrounds or spectra, to be made.

This is done as the wavelength range is scanned, and involves continuously adjusting the high voltage on the PMT or the LAAPD detector gain to deliver the optimum photometric DC voltage via the electronics to the analog to digital converters. This high voltage or gain control to maintain the photometric DC voltage is referred to as AutoPM.

Because of this process the detector gain will routinely vary during a scan and between reference (background) and sample CD measurements so that the conditions for the normal absorbance calculation are not met.

In order for spectrometer to deliver accurate absorbance spectra the following method has been developed which accounts for the variable gain element in the calculation.

For the LAAPD detector, the internal gain of the detector is constant, while an amplifier stage is used to control the absolute gain. The absolute gain, and thus the change in gain between two measurements is therefore always known. This is unlike the PMT detector where the gain has to be estimated.

For the Chirascan PMT, the current gain is given by Equation 6.7 [2]:

\[
\mu = \frac{I_a}{I_C} = \alpha \frac{a^n}{(n+1)^{10}} HV^{10}
\]

(6.7)

where \( \mu \) is the current gain, \( I_a \) and \( I_C \) are the anode and cathode currents respectively, \( n \) is the number of dynodes in operation, \( k \) and \( a \) are constants dependent on photomultiplier design and material, \( \alpha \) the collection efficiency and \( HV \) the applied high voltage.
As described above, during a scan a constant DC signal voltage is targeted, by varying the current gain of the photomultiplier. This is achieved by software control of the detector high voltage ($HV$).

From Equation 6.6 the reference and sample DC signals can be expressed as:

$$DC_{REF} = f \cdot \mu_{REF} T_{REF}$$

(6.8)

$$DC_{SAMP} = f \cdot \mu_{SAMP} T_{SAMP}$$

(6.9)

where $\mu_{REF}$ and $\mu_{SAMP}$ are the two photomultiplier gains necessary to obtain $DC_{REF}$ and $DC_{SAMP}$ from the light transmitted by the reference and sample respectively ($f$ represents an appropriate conversion constant dependent on the units of $T$).

If, however, $DC_{REF}$ and $DC_{SAMP}$ are the same (which is the purpose of the AutoPM function) then the following holds:

$$\mu_{REF} T_{REF} = \mu_{SAMP} T_{SAMP}$$

(6.10)

and:

$$\frac{T_{REF}}{T_{SAMP}} = \frac{\mu_{SAMP}}{\mu_{REF}}$$

(6.11)

therefore

$$A = \log \frac{\mu_{SAMP}}{\mu_{REF}}$$

(6.12)

For a PMT detector, Equation 6.7 can be simplified to:

$$\mu = K (HV)^p$$

(6.13)

for a particular detector where:

$$K = \alpha \frac{a^p}{(n+1)^m}$$

(6.14)

and:

$$Z = kn$$

(6.15)

therefore:

$$A = \log \frac{K(HV_{SAMP})^p}{K(HV_{REF})^p}$$

(6.16)

Re-arranging this yields:

$$A = Z \log \frac{HV_{SAMP}}{HV_{REF}}$$

(6.17)

$Z$ is the only constant photomultiplier-dependent term remaining and can be obtained easily by a simple calibration step. For a given detector and dynode configuration it is a dimensionless quantity between 5 and 6.
Therefore under conditions where the same target DC level is achieved using the AutoPM function, Equation 6.12 (LAAPD) or Equation 6.17 (PMT) can be used to accurately calculate the absorbance from the detector high voltage used for the reference and sample measurements.

However, in practice, the AutoPM function returns when a signal DC level is within a tolerance window close to the target value. This lack of accuracy would introduce errors into the calculation above. However this error can be corrected by re-introducing a term based on the classical calculation in Equation 6.6.

From Equations 6.6, 6.8 and 6.9:

\[ A = \log \frac{T_{REF}}{T_{SAMP}} = \log \frac{\mu_{SAMP}DC_{REF}}{\mu_{REF}DC_{SAMP}} \]  

(6.18)

Here we retain the individual DC terms for sample and reference to account for the AutoPM discrepancy. For a LAAPD detector, this formula allows an accurate absorbance to be calculated when the individual DC signal levels are recorded together with the detector gains. For the PMT detector we can derive the following:

\[ A = \log \frac{K(HV_{SAMP})^2 DC_{REF}}{K(HV_{REF})^2 DC_{SAMP}} \]  

(6.19)

and finally:

\[ A = Z \log \frac{HV_{SAMP}}{HV_{REF}} + \log \frac{DC_{REF}}{DC_{SAMP}} \]  

(6.20)

Which allows an accurate absorbance to be calculated when the individual DC signal levels are recorded together with the PMT detector high voltages.

It can be seen that in the event of the HV being constant and the AutoPM function is not applied Equation 6.20 simplifies to the classical Absorbance calculation in Equation 6.6. If the AutoPM function is perfect and the target DC signals are the same then only the left hand term applies and the calculation is the same as in Equation 6.17. Any intermediate situation is accommodated through application of the full expression, Equation 6.12 (APD) or Equation 6.20 (PMT).

### 6.4 Adaptive sampling

#### 6.4.1 Introduction

Incoming signal data on the spectrometer is digitally averaged to reduce measurement noise. The raw signal is bandwidth limited before digitisation at a default frequency on all channels of 40 kHz (max 100 kHz). The signal to noise \((s/n)\) improvement yielded by this averaging follows a square root relationship to sample size \((N)\), i.e.

\[ s/n \propto \sqrt{N} \]  

(6.21)

The averaging is carried out in the Windows driver and can be controlled by the operator from the spectrometer control panel. The sample size for each average is more usefully expressed as a resulting time-per-point e.g. if \(N = 40000\) the time-per-point will be 1 second at a sample period of 25 \(\mu\)s. The spectrometer moves to, and stops at, each wavelength in the spectrum to carry out this sample average before proceeding to the next wavelength. The overall scan time is given by the following relationship:
Scan-time = (Time-per-point + step-time) x total wavelength-steps

The step-time is a time overhead comprising a contribution from the time taken for the wavelength drive to move to the next wavelength and a short settling time prior to signal acquisition. It only becomes significant during rapid scans with minimal signal averaging. Total wavelength-steps is also equal to the product of the scan range and scan resolution (in steps/nm) plus 1.

CD is a demanding technique due to the commonly very small magnitude of $\Delta A$ to be measured (typically $10^{-4}$ to $10^{-5}$ AU) and the high degree of photon shot noise in regions of the spectrum where light throughput is limited. This means that signal integration (averaging) over time is essential, and scan times are typically of the order of several minutes, particularly when extending into the far UV. The selection of a time-per-point is almost always going to be dictated by the adequacy of the noise reduction in this region of the spectrum and not by the less demanding requirements of regions of the spectrum where there is plenty of light (almost everywhere else).

The result is that in some circumstances, in order to have adequate noise improvement in the far UV, much time will be spent averaging data elsewhere in the spectrum where it is not necessary.

The purpose of the adaptive sampling option is to increase scanning efficiency by dynamically altering the data averaging sample size according to the light throughput as the scan proceeds. This unique feature of the Chirascan series spectrometers is made possible by variable real-time digital signal averaging.

6.4.2 The AutoPM function

During a normal CD scan, the monochromator moves to successive points in the wavelength range of the scan. At each position the CD signal is optimised, by tuning the gain on the detector (by changing the applied high voltage). In the spectrometer software the AutoPM function performs this feedback control. It operates by increasing or reducing the HV of the PMT detector or gain on the output of the LAAPD detector until the optimum photometric DC voltage is achieved regardless of incident light intensity. This best matches the digitisation stage and results in the best quality CD resolution. In regions of the spectrum where there is a high photon flux (high light level) the required HV will be relatively low, whereas in regions of the spectrum where there is a low photon flux (for example in the far UV) the HV (PMT) or gain and associated emulated HV (LAAPD) will be increased. To protect the PMT detector, the maximum HV is 1000 volts, which will be reached at the very lowest light levels. Note that at the very lowest light levels the emulated HV on the LAAPD will also reach 1000 volts, which is a gain of 4096 over the internal detector gain, and the maximum permitted.

It should be noted that if the HV or emulated HV has reached its maximum level, and the incident light continues to fall, the CD signal can no longer be further optimised. However, even with reduced signal levels a good CD signal can still be measured. A very high HV or emulated HV is not necessarily an indication that there is no CD signal.

6.4.3 The adaptive sampling algorithm

Adaptive sampling aims to optimise the overall scan time by spending more time collecting data where it is most needed, which means in regions of low light intensity, and to scan more quickly where light is plentiful. This function has been optimised to maximise the signal to noise ratio of the PMT detector of the Chirascan. In what follows, the description of the algorithm is based on the Chirascan PMT, but the Chirascan-plus LAAPD has been designed to have a similar relationship between emulated HV, gain and photon shot noise, and the algorithm works equally effectively.

By reducing the number of samples (reducing the sampling time-per-point) in regions of high light flux, a spectrum can be measured in a shorter time. Put another way, the use of adaptive sampling can lead to better
spectra being measured in the same time. With careful experimentation, using adaptive sampling can produce better CD spectra in a shorter period of time.

Although the relationships between HV, gain and photon noise are quite complex, it is also true that, for a given detector, the observed photon noise amplitude is a direct function of the applied HV, and to a large extent independent of other instrumental parameters such as wavelength or bandwidth. By using the relationship in Equation 6.6 it is possible at any HV to equalise the noise in averaged data by a suitable adjustment in the sample size i.e. as the light flux reduces and the HV rises, when a doubling of photon noise occurs this can be compensated for by a 4-fold increase in the average sample size. This is the basis of the Chirascan’s adaptive sampling mechanism.

Implementation of the approach required making measurements of the noise variance of a typical detector as a function of HV. Some sample results are shown in Figure 6.5, in which noise variance is plotted against HV, at constant photometric DC target. A clear non-linear increase in signal variance with HV can be seen between 200 and 1000 volts (the usual operating range of the detector).

![Figure 6.5: noise variance against HV at constant DC target](image)

The data were then used to construct a plot of required relative average sample size required to maintain a constant noise level versus HV. Fitting an empirical formula to this data yields the continuous curve shown in Figure 6.6, enabling a relative sample size to be calculated for any HV.
To make use of this function we first define a default sample size and reference HV which act as the starting point for the adaptive algorithm. These values determine a default time-per-point and noise level which is broadly acceptable for typical spectral measurements into the far UV, but which can be dynamically adapted by the algorithm to improve the scan efficiency as the light throughput varies. These values are the default sample size (20000 or 0.5 seconds time-per-point) and an HV of 800 volts.

If adaptive sampling is not active and the scan proceeds, a 20000-point average will be calculated at every wavelength in the scan range.

If adaptive sampling is selected then the sample size and therefore the sample time is increased or reduced according to the relative sample size function:

\[ Y = \exp(-0.003(800 - HV)) \]  

Thus at the reference HV of 800 volts, the adaptive sampling scaling factor \( Y \) is 1.0; at an HV of 500 volts, the sampling scaling factor is 0.407 and at an HV of 1000 volts, the scaling factor is 1.82.

So, at 1000 volts there would be roughly twice as much time spent acquiring each point as compared to the default time-per-point. At HV levels of 500 volts, each point would be measured in roughly 40% of the default time.

The net effect for a typical sample is that a scan should be faster with adaptive sampling than without for the same default sample size, particularly if the scan extends into high light throughput regions of the spectrum. This will be offset to some extent by increased time spent where light is limited – in the far UV and in the presence of absorbing solvents - but here there will be a small enhancement to the signal to noise.

It is also possible for the user to change the default number of samples and therefore the default time-per-point used during normal and adaptive sampling. Minimum and maximum sample sizes can also be modified to limit the sampling extremes during adaptive sampling.
In conclusion, the adaptive sampling option will not always offer significant benefits, but with experimentation will result in scan time improvements for certain samples and scan wavelength ranges.

6.5 Data filtering
6.5.1 Introduction
Signals derived from photomultipliers inevitably have photon shot noise superimposed which is due to the random nature of photon detection events at the photocathode. This is of high frequency and Gaussian in distribution and is usually the most significant type of random noise contributing to the overall noise in a CD measurement. Other sources of noise include electronic noise and noise which arises from the PEM modulation frequency of 50 kHz.

There are three distinct forms of signal filtering which are implemented or available on the spectrometer:

- Signal bandwidth limiting and noise rejection in the analog electronics.
- Post-acquisition signal averaging for shot noise reduction where signals are weak.
- Cosmetic smoothing of experimental results for presentation.

The first of these is an essential and optimized part of the processing of the raw analog signals prior to digitization, whereas the second two are flexible and under operator control.

6.5.2 Electronic filtering
Firstly, prior to digitization of the analog signals, it is important that signals are bandwidth limited to less than half the A/D sampling frequency (the Nyquist critical frequency) to prevent the aliasing of high frequency noise into the frequency spectrum of the measurement. This is well known from sampling theory [3] and is essential in any instrument which digitizes analog signals at discrete intervals. A 200 μs, 1 kHz low pass filter on the CD channels (AC and DC) provides this filtering and also rejects any components of the PEM carrier frequency (50 kHz). This fixed time-constant is the only pre-acquisition filter applied to the analog signal and is not user adjustable.

6.5.3 Signal Averaging
The digitized signals will still exhibit photon shot noise passed by the electronic filtering stage. This noise can often mask spectral features, or at least make them difficult to see, particularly in demanding regions of the spectrum such as the far UV. Filtering of this noise is carried out primarily for cosmetic reasons.

The primary method of noise filtering over which the user has control is sample averaging. This is carried out following digitization but during the acquisition process, and simply involves averaging digitized samples together. This yields a signal to noise improvement proportional to the square root of the number of averaged samples (Equation 6.21). To prevent smearing of spectral information, the monochromator moves to each wavelength in the scan and the sampling is carried out before the monochromator moves on to the next wavelength. The averaged measurement is then a true reflection of the input signal at that wavelength. This is in marked contrast to the application of variable time constant filtering during continuous scanning modes on earlier spectrometers. Here the smoothed result for a particular wavelength has a decreasing contribution from the signal at earlier wavelengths visited, to the point that spectral features can be skewed and attenuated during the process.

On Chirascan series spectrometers, the average sample size is represented by a time-per-point parameter based on the current sampling period (default setting 25 μs). Because the wavelength drive pauses while the samples are collected, the size of the sample is directly responsible for the time spent per point and therefore the overall scan time. The user can adjust this parameter depending on the signal to noise required for the new
spectrum and the time frame desired for the scan. However he or she can be confident that the resulting data are always an accurate representation of the original unfiltered data and that the noise reduction is statistically sound and free from the distortion risks which accompany the use of other online filtering methods.

6.5.4 Cosmetic smoothing
The acquired spectrum will probably still exhibit a degree of wavelength dependent noise which can be further reduced for enhanced visualization and publication purposes using off-line digital smoothing techniques. The digital smoothing method available in the spectrometer software is based on the Savitzky-Golay algorithm [4].

Because such filtering methods can over-smooth the spectrum, distorting the underlying spectral features, the smoothed results are always accompanied by a display of the residual spectrum which is the difference between the raw and smoothed data. Any systematic trend in this residual plot is evidence of over-smoothing and the result should be discarded. A random residual indicates a smooth free from distortion (Figure 6.7).

![Figure 6.7: raw, smoothed and residual CD data](image)

6.6 References
1. PEM-90 Photoelastic Modulators, Hinds Instrument Inc, 3175 N.W.Aloclek Dr., Hillsboro, OR 97124-7135, USA.